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INTRODUZIONE  
 
 
 
 
 
 
 

 
Questa introduzione fornisce una rapida panoramica 

degli argomenti trattati nel manuale SDL Trados Studio 

2011 Intermediate for Translators. 
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SCOPO DI QUESTO CORSO 
 

Il corso SDL Trados Studio 2011 Getting Started for Translators spiegava come tradurre file 

utilizzando le tecnologie CAT, vale a dire le memorie di traduzione, i dizionari AutoSuggest 

e i termbase. 
 

Questo corso porta l'utente al livello successivo. Tra le altre cose, si imparerà a: 
 

 Lavorare su più file con la creazione di progetti 

 Eseguire attività come l'analisi dei file e la pretraduzione 

 Leggere report di progetto e statistiche 

 Eseguire operazioni Trova/Sostituisci 

 Visualizzare solo alcuni segmenti di un documento, ad esempio tutti i segmenti non 

confermati, tutti i segmenti che contengono un dato termine, ecc. 

 Unire più documenti in un unico file 

 Usare la funzione controllo di qualità automatico per individuare nelle traduzioni ad 

esempio l'aggiunta di spazi vuoti, potenziali problemi di lunghezza, errori 

terminologici, ecc. 

 Modificare le impostazioni di autopropagazione 

 Revisionare i file e tenere traccia delle modifiche 

 Personalizzare i tasti di scelta rapida 
 
Il manuale si concentra principalmente su esempi pratici per i quali sono disponibili sample 

file per le esercitazioni. 
 

Si consiglia di copiare i sample file sul proprio desktop in modo da trovarli facilmente 
(...\Desktop\Sample Files). 

 



 

 

 
 
 
 
 
 
 
 
 
 
 

LAVORARE SU PIÙ FILE 

ATTRAVERSO I PROGETTI  
 
 
 
 

 
Nel seguente capitolo si imparerà a: 

 
 Creare un progetto per la gestione efficace 

di più file 

 Selezionare la coppia di lingue del progetto 

 Aggiungere al progetto file source e di riferimento  

 Aggiungere al progetto TM, dizionari AutoSuggest 

e termbase  

 Preparare automaticamente i file di progetto 

 Creare un modello di progetto dal progetto 

attuale 
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QUANDO CREARE UN PROGETTO 
 

La schermata Home di SDL Trados Studio 2011 presenta quattro pulsanti principali 

attraverso i quali è possibile accedere ad alcune funzioni di uso più frequente. Il corso SDL 

Trados Studio 2011 - Parte I si concentrava sulla traduzione di singoli file attraverso la 

funzione Open Document. 
 

In questo corso sarà illustrata la funzione New Project. Una domanda frequente è: quando 

usare Open Document e quando invece New Project? In generale si usa la funzione New 

Project quando è necessario lavorare su diversi file che devono essere tradotti in una o più 

lingue target. Questo consente di evitare di aprire e salvare ciascun file individualmente. 
 

Un buon esempio è un sito web composto da 100 pagine. Se si lavora a un progetto di 

questo tipo, non conviene aprire e salvare tutti i documenti uno per uno. 

 
 

In questo esercizio si vedrà come creare un piccolo progetto di esempio a cui lavorare. I 

sample file per questo esercizio sono reperibili nella seguente sottocartella: ..\Sample 

Files\01_Project. 

 

 

CREARE UN PROGETTO 
 

In questo esercizio si parte dal presupposto di dover tradurre alcuni documenti da gestire 

in un progetto. 

 
 

Inserire i dettagli del progetto  
 

Per iniziare a creare il progetto: 
 

1. Dopo l'avvio di SDL Trados Studio 2011 fare clic su New Project nella schermata 

Home o usare la combinazione di tasti Ctrl+N. 



 

 

 

 
 
 

2. In questo modo si aprirà la prima schermata del wizard New Project. Lasciare 

invariate le impostazioni predefinite e fare clic su Next per procedere. 

 

 



 

 

 

 
 
 

3. Nella pagina Project Details inserire un nome descrittivo per il progetto nel campo di 

testo Name. Poiché questo progetto include una breve documentazione su un 

modulo di controllo ortografico, il nome del progetto potrebbe essere, per esempio, 

Spelling Checker Documentation.  

 

 
 
 

 

NOTA 
Tutti i file di progetto sono archiviati per impostazione predefinita nella cartella 
Documenti, ad esempio C:\Utenti\<NomeUtente>\Documenti\SDL Trados 
Studio\Projects. L'applicazione crea automatica-mente una sottocartella con il nome 
del progetto nella cartella personale Projects. È anche possibile archiviare i progetti in 
una posizione diversa, ad esempio su disco rigido. Per farlo, fare clic sul pulsante 
Browse e scegliere una posizione diversa. È necessario utilizzare una sottocartella 
vuota per ogni progetto per evitare potenziali conflitti tra file. 
 
 

4. Spuntare la casella Due Date. Comparirà un campo in cui inserire la data di consegna 

del progetto. Fare clic sulla freccia accanto al campo di testo. Si aprirà un calendario 

da cui scegliere la data di consegna, per esempio una settimana dopo la data di 

creazione del progetto. 
 

 
 

                  NOTA 
Non è obbligatorio impostare una data di consegna, ma quando si lavora su più 
progetti può essere utile tenere traccia delle priorità e delle date di consegna. 

 

5. Fare clic su Next per proseguire. 

 



 

 

 

 
 

PER ULTERIORI INFORMAZIONI 
 

Project Details Window 
 

 

Selezionare le lingue del progetto 
 

1.  Si apre la pagina Project Languages. I sample file sono in inglese. Assicurarsi che l'opzione English 

(United States) sia selezionata nel menu a tendina Source Language. 
 

2. Selezionare la lingua target dal menu Target Language facendo doppio clic sulla lingua target scelta nel 

menu Available, per esempio Italian (Italy).  
 

 

 
NOTA 
Un progetto può avere solo una lingua source, ma più lingue target. In questo esercizio 
si utilizza un'unica coppia di lingue. 

 
 

 

3. Fare clic su Next per proseguire. 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Screen_Layout/Projects_View/P_Project_Details.htm


 

 

 

 

Selezionare i file del progetto 
 

1. Si apre la pagina Project Files. Qui è possibile selezionare i file source per la traduzione. Fare clic 

sul pulsante Add Files in alto a sinistra nel wizard New Project. 

 
 

2. Si apre la finestra di dialogo Add Files. Cercare la cartella dove sono collocati i sample 

document, per esempio ..\Sample Files\01_Project\Documents. Selezionare tutti i file 

presenti nella cartella e fare clic su Open. 

 
3. In questo modo verranno aggiunti 5 file al progetto: 3 file DOCX, 1 file PPTX, e 1 file 

PDF. 

 
 

4. Tutti i file presenti nella cartella selezionata sono considerati documenti traducibili, 

come indicato nella colonna Usage, impostata automaticamente su Translatable. 



 

 

 

 
 
 

5. Se il documento PDF è stato fornito dal cliente solo come riferimento e non va quindi 

tradotto, si dovrà modificare l'uso del file. Evidenziare il file PDF e fare clic sul 

pulsante Change File Usage. 
 

 
 

 
6. Si apre la finestra di dialogo Change File Usage. Selezionare l'opzione Reference, quindi fare clic 

su OK.  

 

 
7. Confermare il messaggio che informa che l'uso del file è stato modificato con 

successo, quindi fare clic su Next per proseguire. 
 
 

 
 

 
 

 About Project Files 

 About File Usage 
 

 

Selezionare le memorie di traduzione 
 

Sulla pagina Translation Memory and Automated Translation  è possibile selezionare le memorie di 

traduzione e i dizionari AutoSuggest da usare nel progetto. Si può selezionare più di una 

memoria di traduzione per una singola coppia di lingue. Selezionando più memorie di 

traduzione, la ricerca in fase di traduzione comprenderà tutte le memorie presenti. 
 

Procedere come indicato di seguito: 
 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Projects_View/P_About_Project_Files.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Projects_View/File_Usage.htm


 

 

 

 
 
 

1. Nel menu a sinistra della finestra di dialogo selezionare All Language Pairs -> Translation 

Memory and Automated Translation. 

 
 

    NOTA 
Le memorie di traduzione verranno aggiunte sotto l'opzione All Language Pairs anche 
se il progetto contiene più coppie di lingue. La memoria di traduzione aggiunta sotto 
l'opzione All Language Pairs verrà assegnata automaticamente alla coppia di lingue 
corretta del progetto. 

 

2. Per aggiungere la prima memoria di traduzione fare clic su Add -> File-based Translation 
Memory. 

 

 
 

 
3. Cercare la sottocartella che contiene le memorie di traduzione del progetto, nell'esempio 

..\Sample Files\01 - Project\TMs. Fare doppio clic sulla memoria di traduzione Software_EN-

US_IT-IT.sdltm. Questa sarà la memoria di traduzione primaria del progetto. 

 
4. Ripetere il passaggio precedente per la memoria di traduzione General_EN-US_IT-IT.sdltm, che 

verrà usata come memoria di traduzione secondaria. 



 

 

 

 

NOTA 
Nel caso in cui si traduca un file sui software, ad esempio, è possibile che sia la 
memoria Software TM sia la memoria General TM  contengano occorrenze utili, ma la 
prima dovrà essere privilegiata in quanto memoria di traduzione primaria, da 
aggiornare nel corso della traduzione. 

 

5. Assicurarsi che nella colonna Update NON sia spuntata la casella della General TM. 

Così facendo questa memoria di traduzione verrà usata soltanto per fare ricerca, 

ovvero la si potrà usare per la ricerca di segmenti e concordanze. I segmenti tradotti 

di volta in volta non verranno inseriti in questa memoria di traduzione. 
 

 

 
 
 
 
How to Add Translation Resources to a Project 

 

Aggiungere un dizionario AutoSuggest 
 

È possibile a questo punto aggiungere un dizionario AutoSuggest. È utile ripetere che i 

dizionari AutoSuggest sono database separati usati per riconoscere e suggerire frammenti 

di segmento. 
 

1. I dizionari AutoSuggest NON SI POSSONO aggiungere alla voce All Language Pairs, ma 

devono essere assegnati a una specifica coppia di lingue, quindi è necessario fare clic 

su English (United States) -> Italian (Italy) e poi su AutoSuggest Dictionaries. 

 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Projects_View/CreatProjects/CreProj_AddingTR.htm%0A


 

 

 

 

2. Fare clic sul pulsante Add in basso a destra nella finestra di dialogo. 

 

 
 

3. Nella finestra di dialogo Open AutoSuggest Dictionary selezionare la cartella dove è salvato 

il sample file con il dizionario AutoSuggest, ad esempio ..\Sample Files\AutoSuggest 

Dictionaries e fare doppio clic sul file, ad esempio EN-IT.bpm. 

 
4. Ora che il dizionario AutoSuggest è stato aggiunto, scegliere Next per continuare. 

 

 
 

 

   How to Add an AutoSuggest Dictionary  
 

 

Aggiungere un Termbase 
 

1. In Termbases è possibile aggiungere al progetto uno o più termbase. Per aggiungere un 

termbase al progetto procedere come indicato di seguito : 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Setting_Preferences/AutoSuggest/Add_Phrase_Mapping_Bilingual_File.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Setting_Preferences/AutoSuggest/Add_Phrase_Mapping_Bilingual_File.htm


 

 

 

 
 
 

1. Fare clic sul pulsante Add per aprire la finestra di dialogo Select Termbases. 

 
 

 
2. Fare clic su Browse e trovare la cartella in cui è salvato il sample file del termbase, ad esempio 

..\Sample Files\01_Project\Termbase. Quindi fare doppio clic sul file Software.sdltb per 

selezionarlo. 

 
 

 
3. Quando viene visualizzato il nome del termbase (es. Software) nella finestra di dialogo Select 

Termbases fare clic su OK. 

 
4. Si apre una finestra in cui si informa l’utente che le lingue del termbase sono state associate 

alle lingue del progetto. Fare clic su OK per chiudere la finestra. Il termbase dovrebbe ora 

comparire alla voce Termbases. 



 

 

 

 
 
 

5. Nell’elenco Indexes in fondo alla finestra di dialogo è quindi possibile verificare se sono 

state selezionate correttamente le lingue del termbase per il progetto. La colonna Project 

Language mostra la lingua del progetto e la bandiera corrispondente. La colonna Index 

mostra l’indice del termbase che è stato assegnato alla rispettiva lingua di progetto.  

 

 
 

6. Una volta assegnati correttamente gli indici del termbase, non è più necessaria alcuna modifica. 

Fare clic su Next per proseguire. 



 

 

 

 
 
 

  How to Add a Termbase 
 

 

SDL PerfectMatch 
 

È possibile ignorare la schermata SDL PerfectMatch semplicemente facendo clic su Next. La funzione SDL 

PerfectMatch non verrà trattata in questo corso. 

 
 

 
 

  NOTA 
Questa funzione non è disponibile nell’edizione Freelance di SDL Trados Studio 2011. 

 
 
 

 
 

SDL PerfectMatch 
 

 

Preparazione del progetto 
 

La schermata successiva elenca le cosiddette batch task che verranno eseguite sui file del progetto. Le 

batch task sono utilizzate per automatizzare i passaggi come la conversione dei file e il conteggio delle 

parole e delle ripetizioni. 
 

È automaticamente selezionata l’impostazione Prepare without project TM. Questa impostazione contiene un 

numero di batch task che preparano i sample file nel seguente modo: 

  

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Translation_Resources/OpenRe_TB.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/About/About_PerfectMatch.htm


 

 

 

 
 

  Convert to Translatable Format: converte tutti i file del progetto in SDL XLIFF per ulteriori operazioni. 

 Copy to Target Languages: crea copie di lavoro dei file e le salva in cartelle separate, divise per lingua, 
per evitare conflitti e sovrascritture involontarie dei file source. 

 Apply PerfectMatch: confronta i file source correnti con file bilingui precedentemente tradotti per 
una pretraduzione affidabile. Questa funzione non verrà trattata in questo esercizio. 

 Analyze Files: esegue un conteggio delle parole e dei segmenti, calcola la frequenza delle ripetizioni e 
la rilevanza della TM, ossia determina il numero di perfect match e fuzzy match che possono essere 
recuperati dalle TM. 

 Pre-translate Files: se nelle TM si trovano perfect match, questi verranno automaticamente aggiunti ai 
documenti una volta completata questa attività. 

 

 
 

FREELANCE 

Nella versione Professional di SDL Trados Studio 2011 è possibile personalizzare le batch task per adattarle 
a particolari richieste di lavoro. Questo non è possibile nell’edizione Freelance. 
 

1. Fare clic su Finish per avviare la preparazione automatica del progetto. 

2. Verrà visualizzata la pagina Preparing Project. L'applicazione sta ora elaborando automaticamente 
le batch task individuali per preparare i file del progetto. Attendere il completamento di tutti i 
processi in corso. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

V 
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Project Preparation 

 

Creare un modello di progetto 
 

Ora che il progetto è stato creato, si potrebbe avere l'impressione che la procedura richieda un numero di clic 

decisamente maggiore rispetto all'apertura di un singolo file, poiché bisogna superare varie schermate del wizard, 

selezionare le TM, i termbase, ecc. 
 

Ciò potrebbe essere vero inizialmente. Va ricordato, però, che i progetti fanno risparmiare tempo e fatica nel caso 

in cui si debba tradurre un discreto numero di file. È possibile inoltre creare modelli di progetto, così nei progetti 

successivi sarà sufficiente dare un nome al progetto e aggiungere i file source. Tutte le altre impostazioni, ad 

esempio la selezione delle lingue, delle TM, dei termbase ecc., saranno predisposte secondo il modello. 
 

Se per esempio in futuro si avrà a che fare con molti altri progetti che seguono lo stesso schema, allora avrà senso 

creare un modello basato sul progetto corrente. (In uno dei capitoli seguenti si illustrerà come utilizzare questo 

modello per creare più velocemente un secondo progetto.) 
 

Per creare un modello seguire questo procedimento: 
 

1. Selezionare l’opzione Create a new project template based on this project in fondo al wizard New Project. 

Poi fare clic su Close. 

 
 

2. Nella finestra di dialogo Save Project Template inserire il nome del modello, ad esempio 

Template English-Italian, quindi fare clic su Save per creare il file del modello. 
 

D NOTA 

Questo modello sarà utilizzato in un altro capitolo per creare più velocemente un secondo progetto. 
 
 

Visualizzare il progetto 
 

Fare clic su Projects View in fondo al pannello Navigation. In questa visualizzazione è possibile vedere il progetto 

appena creato nella schermata Projects.

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Projects_View/CreatProjects/P_Project_Preparation.htm


 

 

 

 
 
 

È possibile vedere le informazioni essenziali di ogni progetto qui elencato, come il nome, lo stato (es. In Progress), la data di 
consegna, ecc. 

 
 

Per vedere dove sono salvati fisicamente i file di progetto nel disco rigido, procedere come indicato di seguito: 
 

1. Fare clic con il tasto destro del mouse sul progetto e selezionare Open Project Folder dal menu di scelta rapida. 
 

 



 

 

 
 
 

2. Si aprirà la cartella in Esplora risorse, dove sono conservati tutti i file di progetto, come i 

documenti source e target. Per il sample project la cartella contiene le seguenti 

sottocartelle: 
 

  
 

3. La cartella en-US contiene i file originali. La cartella it-IT contiene le copie in lavorazione in 

formato SDL XLIFF. Questi sono i file su cui si lavora effettivamente durante la traduzione. 

La cartella Reports contiene i report generati dalle batch task AnalyzeFiles e Pre- 

translateFiles. Il report sarà analizzato in dettaglio nel prossimo capitolo. Il file *.sdlproj è il 

file di progetto che contiene tutte le informazioni sul progetto, ad esempio nome, data di 

consegna, ubicazione delle TM, dei termbase, ecc. 

 
A questo punto è possibile chiudere Esplora risorse. 

 
 

RIEPILOGO 
 

 Quando è necessario tradurre diversi file, si raccomanda di creare un nuovo progetto, 

anziché aprire ogni file individualmente. 

 Un progetto può avere un’unica lingua source, ma più lingue target. 

 La creazione del progetto è interamente basata su wizard. Nelle varie schermate si 

assegnano al progetto nome edata di consegna, si selezionano ifile source, le TM, i 

termbase e i dizionari AutoSuggest. 

 I file che possono essere tradotti con SDL Trados Studio 2011 sono indicati come 

translatable (ad esempio DOC, PPT, PDF, ecc.). Tuttavia i file che non fanno parte del 

processo di traduzione possono essere indicati come reference. 

 Al termine della creazione del progetto i file vengono preparati automaticamente 

tramite le batchtask, che convertono, analizzano ed eseguono la pretraduzione dei 

file. 

 È possibile creare un modello dal progetto corrente se si prevede di lavorare ad altri 

progetti simili in futuro, che utilizzino per esempio la stessa coppia di lingue, la stessa 

TM, lo stesso termbase, ecc. Questa opzione velocizzerà sensibilmente la creazione 

del progetto. 

 

  



 

 

 

 

 

 
 
 
 

STATISTICHE E REPORT 

DEL PROGETTO  
 
 
 
 
 

Nel seguente capitolo si imparerà a: 

 Ottenere una panoramica delle statistiche del 

progetto e determinare la quantità dei contenuti 

pretradotti 

 Leggere un report di pretraduzione 

 Leggere un report di analisi dei file 
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STATISTICHE DEL PROGETTO 

 
SDL Trados Studio fornisce informazioni sui lavori di preparazione del progetto, come il 

numero di parole pretradotte, la quantità di ripetizioni, ecc. 

 
 

Visualizzare le statistiche di conferma 
 

Al momento della creazione del progetto, sono stati pretradotti i file grazie ai perfect 

match ricavati dalle TM selezionate. Per avere una panoramica di quanto contenuto sia 

stato già pretradotto utilizzando le TM, seguire questi passaggi: 
 

1. Nel Projects View fare clic sulla scheda Confirmation Statistics in basso nella finestra 

dell’applicazione. 

 
 

2. Compare così un grafico a barre in basso a destra. La barra Not Translated indica il 

numero di parole non tradotte, ovvero il nuovo contenuto che deve ancora essere 

tradotto o modificato. 

 
3. La barra Translated indica il numero di parole tradotte. Questo è il contenuto per cui 

sono stati trovati perfect match nelle TM. 

      NOTA 
Ci sono altri stati, come Reviewed e Signed-off, che però non verranno trattati in 
questo capitolo. 

 

 

Visualizzare il report dei file pretradotti 
 

Il grafico a barre fornisce una buona panoramica di quanto contenuto è stato pretradotto. 

Per ulteriori dettagli visualizzare il report Pre-translate Files. Per farlo, procedere come 

indicato di seguito: 



 

 

1. Fare clic sul pulsante Reports View in basso nel pannello Navigation sul lato sinistro 

della finestradell’applicazione. 
 

 
 

 
2. Fare clic su Pre-translate Files nella parte superiore del pannello Navigation. 

 

 
 

 
3. Verrà visualizzato il report corrispondente nella parte destra. Questo report fornisce 

una panoramica di quanti segmenti sono stati automaticamente pretradotti 

utilizzando le TM specificate durante la creazione del progetto. Si osservi la sezione 

Totals, che riassume le statistiche delle pretraduzioni per tutti i documenti source. La 

riga Translated indica il numero e la percentuale di segmenti, parole e caratteri 

pretradotti. 

 
 

4. La riga Untranslated indica il numero e la percentuale di segmenti, parole e caratteri 

che devono essere ancora tradotti, ovvero che non sono stati modificati in fase di 

pretraduzione. È possibile che ci siano fuzzy match, così come che non ci siano 

corrispondenze. 

SUGGERIMENTI 

Nella sezione Totals si trovano i File Details, che mostrano le statistiche di 
pretraduzione per ogni singolo file. 

 

 

Visualizzare il report di analisi dei file 
 

Si possono ottenere maggiori informazioni dall'Analyze Files Report. Questo report fornisce non 

solo il numero delle parole e dei segmenti pretradotti, ma anche informazioni sul numero dei 

fuzzy match contenuti nelle TM, sulle ripetizioni, ecc. 
 

Per visualizzare l'Analyze Files Report procedere come indicato di seguito: 



 

 

 
 

 
1. Fare clic su Analyze Files nella parte superiore del pannello Navigation. Verrà così 

visualizzato l'Analyze Files Report sulla destra. 
 

 
 

 
2. Osservare la tabella Totals, che fornisce informazioni generali su tutti i file contenuti 

nel progetto. 

 
 

 

Risultati dell'Analyze Files Report 
 
Leggendo dal basso verso l'alto: 

 

 La riga Total nell'esempio qui sopra indica il numero totale di segmenti e di parole. 

 La riga New indica il numero di segmenti e di parole per i quali non sono state trovate 

corrispondenze nelle TM. 

 Nelle righe sopra New (es. 50%-74%) compare il numero di segmenti e di parole per i 

quali sono stati trovati fuzzy match nelle TM.  

 I fuzzy match non vengono pretradotti per impostazione predefinita. 

 La riga 100% indica il numero di corrispondenze esatte. 

 La riga Context Match indica il numero di segmenti e di parole per i quali nella TM 

sono stati trovati i cosiddetti context match. Questi sono segmenti per i quali è stata 

trovata una corrispondenza al 100% nelle TM e che sono preceduti da un segmento 

identico a quello che li precede nelle TM. Per questo motivo i context match sono 

considerati ancora più affidabili dei 100% match. 

 La riga Perfect Match indica il numero di segmenti e di parole che sono stati 

pretradotti utilizzando SDL Perfect Match (PM). Il Perfect Match sfrutta i file bilingui 

pretradotti per traduzioni preliminari contestuali più affidabili. Tuttavia, dato che non 



 

 

è stato fornito nessun file preliminare al momento della configurazione del progetto, 

questa riga non è rilevante. 

 La riga Repetitions mostra il numero di segmenti per i quali nella TM non è stata 

trovata alcuna corrispondenza, ma che si ripetono all'interno dei documenti. 

 
 
 

RIEPILOGO 

 
 La scheda Confirmation Statistics nella schermata Project View riporta una 

panoramica del numero di parole tradotte e non tradotte in un progetto. 

 Dalla scheda Reports View si possono visualizzare informazioni più dettagliate. 

 Il report dei Pre-translateFiles, che è stato creato dalla funzione di pretraduzione 

delle batch task, fornisce informazioni dettagliate sul numero di segmenti, parole e 

caratteri pretradotti. 

 L'Analyze Files Report, creato dalla funzione di analisi delle batch task, fornisce 

informazioni dettagliate sull'utilizzo della TM, ovvero il numero di corrispondenze 

esatte e parziali che potrebbero essere recuperate dalle TM per uno o più 

documenti in un progetto. 



 

 

 
 
 
 
 
 
 
 
 
 

TRADURRE I FILE DEL PROGETTO  
 
 
 
 
 

                 Nel seguente capitolo si imparerà a: 

 Selezionare dalla TM una delle corrispondenze 

 Trovare e sostituire un termine in un documento 

 Modificare la segmentazione mentre si 

traduce, unendo e dividendo i segmenti 

 Passare velocemente a un determinato segmento 

 Filtrare i segmenti nella schermata Editor 

 

Capitolo 

4 



 

 

 
 
 

VISUALIZZARE I FILE DI PROGETTO 

 
Per tradurre i file contenuti nel progetto seguire queste istruzioni: 

 
1. Fare clic sul pulsante Files per passare alla schedaFilesView. 

 

 
 

 
2. In questa visualizzazione tutti i file di progetto (traducibili e di riferimento) sono 

elencati sulla destra.  
 

Nell'elenco sono anche visualizzati il numero totale di parole per ogni file e la barra di 

avanzamento, che indica la percentuale di contenuto pretradotto per ogni file. 
 

 
 

Per esempio, il primo documento traducibile nell'elenco (Configuration.doc.sdlxliff) è stato 

pretradotto al 60%. Per aprire il primo file per la traduzione nella visualizzazione Editor, 

fare doppio clic sul nome del file. 

 

 

FILTRARE I SEGMENTI 
 

Come si può vedere, questo documento contiene un numero di corrispondenze 
pretradotte (exact match). 

 
 



 

 

Se ci si vuole concentrare su quei segmenti che non sono stati tradotti, SDL Trados Studio 

permette di filtrare i segmenti per mostrarne solo alcuni rispondenti a una certa 

caratteristica, per esempio tutti quelli non confermati. Questa funzione si chiama Display 

Filter. Per attivare la funzione Display Filter seguire questo procedimento: 
 

1. Selezionare il comando del menu View ->Toolbars -> Display Filter. 

2. In questo modo la barra degli strumenti Display Filter viene visualizzata nell’Editor. 

3. Dal menu a tendina Display nella barra degli strumenti Display Filter selezionare Not 

translated. 

 

 
 

 
 

 

 

 

 

 

 

 

 

 

4. Ora sono mostrati solo i segmenti non tradotti. Si può così iniziare a tradurre il primo 

segmento visualizzato. Per questo segmento, si dovrebbero avere occorrenze 

dall’AutoSuggest da poter inserire nel segmento target. 

 
 

 

PER ULTERIORI INFORMAZIONI 

Display Filter Toolbar - Editor  
 
 

SELEZIONARE UNA DELLE CORRISPONDENZE DALLA TM  
 

Dopo aver confermato il primo segmento con la combinazione di tasti Ctrl+Enter si passa al 
segmento successivo. Si osservi la finestra Translation Results sopra il documento. 

  



 

 

La TM mostra tre corrispondenze, elencate in base alla percentuale di corrispondenza, 
ossia a partire dalla più alta. 

 

 
 

Il segmento con la percentuale di corrispondenza più alta è quello che viene usato più 
spesso, dato che assomiglia di più al segmento corrente e quindi richiede un minor numero 
di modifiche. Tuttavia è possibile che venga preferito un segmento con una percentuale di 
corrispondenza minore. 
 
Per selezionare dalla TM una delle corrispondenze seguire questi passaggi: 
 
1. Per spostarsi nell’elenco delle corrispondenze, usare i pulsanti sulla barra degli 

strumenti Select Next Match e Select Previous Match. In questo modo la corrispondenza 

selezionata verrà evidenziata nella finestra Translation Results e la traduzione 

corrispondente verrà inserita nella cella target in modalità Editor. 
 

 
 

 
2. In alternativa ai pulsanti della barra degli strumenti sopra menzionati, è possibile 

premere il tasto Alt e il numero della corrispondenza nella TM, per esempio Alt+1 per 

la prima corrispondenza, Alt+2 per la seconda, ecc. 

 
3. Tutte e tre le corrispondenze provengono dalla stessa TM, come si può notare dal 

nome della TM selezionata, che compare nella barra di stato della finestra Translation 

Results. 



 

 

 
 

 
4. Nell'esempio in questione, la prima corrispondenza sembra essere la migliore. 

Quindi, selezionare la corrispondenza (premere Alt+1), modificarla come indicato e 

confermarla premendo Ctrl+Enter. 

 
5. Ci si dovrebbe ora trovare nel segmento successivo, per il quale non è stata trovata 

alcuna corrispondenza, e che sarà quindi necessario tradurre da zero. Saranno 
comunque presenti alcune utili occorrenze dal dizionario AutoSuggest. Tradurre il 
segmento e confermare premendo Ctrl+Enter. 

 

6. A questo punto, ci si dovrebbe trovare nel segmento successivo, per il quale è stato 

trovato un fuzzy match. Basterà dunque sostituire la stringa Microsoft Word con 

l'equivalente di the application nella lingua target. Confermare il segmento con 

Ctrl+Enter. 
 

 
 
 

INSERIRE CARATTERI SPECIALI 
 

Il prossimo segmento presenta un fuzzy match. Nel segmento target, è necessario 

aggiungere la traduzione della stringa for example Win95 or Q4, che è preceduta da un 

trattino. 

 
 

SDL Trados Studio offre un facile metodo di inserimento per i caratteri speciali come il 
trattino: 

 
1. Posizionare il cursore nel punto in cui si vuole inserire un carattere speciale nel 

segmento target. 
 



 

 

2. Per inserire il carattere speciale richiesto, fare clic sul pulsante della barra degli 
strumenti En dash. 

 
 

3. Procedere aggiungendo la traduzione per esempio Win95 or Q4 dopo il trattino. Non 

dimenticare di applicare la formattazione corsivo utilizzando la funzione QuickPlace. 

Per farlo, selezionare la parte di segmento che richiede quella formattazione, poi 

premere Ctrl+I e selezionare la formattazione richiesta dall'elenco. 
 

 
 
 
 

SUGGERIMENTI 

Con la barra degli strumenti è possibile inserire altri caratteri speciali, ad esempio il 
simbolo del copyright o di un marchio e le virgolette. Questa barra degli strumenti però 
dipende dal tipo di file, quindi potrebbe risultare diversa a seconda del formato del file da 
tradurre. 

 
 
 

RIMUOVERE LA FORMATTAZIONE 
 

Potrebbe capitare che il segmento target contenga delle formattazioni in grassetto assenti 

nel segmento source, ad esempio la parola inglese numbers non è formattata in grassetto, 

mentre la sua traduzione nel segmento target lo è, come si vede nell’esempio: 

 

 
 

Per rimuovere la formattazione procedere come indicato di seguito: 
 

1. Selezionare la parola formattata. 
 
2. Fare clic sul pulsante della barra degli strumenti Force bold off. Questo disabiliterà la 

formattazione carattere in grassetto dalla parola selezionata. 
 

 
 

 
I passaggi indicati qui sopra possono essere utilizzati per rimuovere efficacemente la 

formattazione, che non verrà mostrata nella schermata Editor né durante la creazione del 

file target. 

 

Per impostazione predefinita SDL Trados Studio non mostra i tag per la formattazione del 

carattere. La formattazione viene visualizzata solamente in modalità WYSIWYG. 



 

 

Nonostante i tag non vengano visualizzati, però, sono comunque presenti e inseriti nella 

TM. 
 
Ricorrendo all'impostazione predefinita non vengono visualizzati i tag della formattazione 

del carattere, ma a volte, ad esempio per risolvere alcuni problemi, è utile visualizzare 

questi tag. Per mostrare i tag di formattazione seguire questi passaggi: 
 

1. Fare clic sul pulsante della barra degli strumenti Toggle display of formatting tags. 
 

 
 

 

2. Facendo clic su questo pulsante è possibile attivare e disattivare la visualizzazione dei 

tag di formattazione. Quando questa visualizzazione è attiva il segmento target 

corrente appare così: 
 

 
 

 

È interessante notare che la parola selezionata (per la quale è stata forzata la 

formattazione in grassetto) è ancora racchiusa da una coppia di tag. Spostando il cursore 

su uno dei tag è possibile visualizzarne la descrizione. La prima coppia di tag serve per 

attivare la formattazione in grassetto: 

 

 
  

La seconda, che prevale sulla prima, per disattivarla: 
 

 
 

 
Il segmento contiene dei tag che per impostazione predefinita non vengono visualizzati 

ma che vengono inseriti nella TM. Poiché, annullando la formattazione, si inserisce 

un'ulteriore coppia di tag, è possibile disattivare la formattazione in modo diverso per 

evitare che la TM sia piena di tag aggiuntivi. 
 

Seguire questi passaggi: 

 
1. Quando i tag di formattazione sono ancora visualizzati, rimuovere la coppia di tag 

interna, ovvero quella che disattiva la formattazione grassetto. Per farlo, utilizzare il 

tasto  DEL o Backspace. 
 

 
 

 
2. Rimuovendo il tag di apertura della coppia, questa diventerà un "ghost tag". La 

coppia di tag verrà completamente rimossa solo eliminando anche il tag di chiusura. 



 

 

 
 

 
3. Rimangono così solo i tag per la formattazione grassetto, e in effetti la parola 

corrispondente viene ancora mostrata con la formattazione grassetto. Rimuovere 

ora l'altra coppia di tag che racchiude la parola. 
 

 
 

 
Seguendo i passaggi sopra descritti sono stati rimossi in modo efficace sia i tag sia la 

formattazione del carattere. Come mostrato dall'esempio, attivando la schermata dei tag 

di formattazione è possibile risolvere in modo più chiaro ed efficace i problemi di tag e di 

formattazione. L'esempio qui sopra ci mostra come sia inoltre possibile evitare di 

memorizzare tag aggiuntivi nella TM. 
 
Per disattivare la schermata dei tag di formattazione occorre fare di nuovo clic sul 
pulsante della barra degli strumenti corrispondente: 

 

 
 

 
Infine, confermare il segmento premendo Ctrl+Enter. 

 

 

FILTRARE I SEGMENTI IN BASE A UNA STRINGA DI TESTO 
 

Andare ora al segmento 12, per il quale non ci sono corrispondenze nella TM. Tuttavia, il 

termbase propone una traduzione per il termine dialog box. 

 
 

Ora, poiché il termine dialog box compare in diversi segmenti (pretradotti), è possibile 

controllare che le occorrenze precedenti siano state tradotte rispettando il termbase. 

 

Per rendere il compito più semplice, è possibile utilizzare nuovamente la funzione Display 

Filter. Oltre a mostrare solo segmenti di una categoria ben precisa (ad esempio i segmenti non 

tradotti), è anche possibile mostrare solo i segmenti che contengono una determinata stringa 

di testo. Per farlo, seguire questi passaggi: 

 

1. Selezionare All segments dal menu a tendina Display per assicurarsi di visualizzare tutti i 

segmenti, compresi quelli pretradotti. 
 
2. Inserire poi la stringa dialog box nel campo di testo Containing e premere invio.  

 

 
 

3. Verranno così visualizzati solo tre segmenti che contengono la stringa richiesta. Sarà 

quindi molto semplice verificare la traduzione di quella stringa nei vari segmenti che la 



 

 

contengono: 

 
 

4. Come si può notare, la stringa dialog box contenuta nei due segmenti pretradotti era stata 

tradotta in modo diverso rispetto alle indicazioni del termbase. È possibile che la 

traduzione nei segmenti 3 e 4 fosse originariamente corretta, ma che nel frattempo si sia 

concordato e inserito nel termbase un nuovo traducente. In questo caso è necessario 

aggiornare il documento e la TM sulla base di questa modifica. 

 

 

TROVA E SOSTITUISCI SULL’INTERO DOCUMENTO 
 

Sarebbe ovviamente possibile modificare entrambi i segmenti e sostituire il vecchio traducente 

con il nuovo; tuttavia, se il vecchio traducente è stato usato molte volte, potrebbe risultare più 

comodo effettuare una ricerca e una sostituzione sull’intero documento. 
 
Per farlo, seguire questi passaggi: 

 
1. Selezionare Edit->Replace da menu; si aprirà così la finestra di dialogo Find and Replace. 

NOTA 
Assicurarsi che il cursore sia posizionato all'interno del testo. Nel caso in cui il cursore 
si trovi ad esempio nella finestra Translation Results, il comando Edit ->Replace non sarà 
disponibile. 

 

2. Immettere il termine da sostituire nel campo di testo Find what(nel caso in questione,box di 

dialogo). 

3. Inserire il nuovo traducente, ossia finestra di dialogo, nella casella di testo Replace with della 

finestra di dialogo. In seguito fare clic sul pulsante Find Next. 
 



 

 

 
 

 

4. Verrà evidenziata la prima occorrenza della stringa inserita nella casella di testo Find what nella 

colonna target. 

 
 

5. Fare clic sul pulsante Replace nella finestra di dialogo per sostituire la stringa selezionata. Viene 

evidenziata la successiva occorrenza della stringa inserita nella casella di testo Find what. 

 
6. Fare ancora clic sul pulsante Replace per sostituire la seconda occorrenza. 

 
7. Dopo aver sostituito tutte le occorrenze della stringa cercata, compare un messaggio per 

informare che non sono state trovate altre corrispondenze. Fare clic su OK per chiudere il 

messaggio, e su Close per chiudere la finestra di dialogo Find and Replace. 

 
8. Poiché i segmenti sono stati modificati dall'operazione di ricerca e sostituzione, questi sono ora 

in versione Bozza. Inoltre, le modifiche recenti NON sono state aggiunte alla TM. Bisogna perciò 

confermare questi segmenti uno per uno (dopo aver effettuato eventuali modifiche) premendo 

Ctrl+Enter. 

 



 

 

 

9. Per visualizzare di nuovo tutti i segmenti, fare clic sul pulsante Reset all filters della barra degli 

strumenti. 

 
 

PER ULTERIORI INFORMAZIONI  

How to Find and Replace Text  

 

L'ultimo segmento è una ripetizione del primo. È stato quindi autopropagato dalla prima occorrenza. I 
segmenti autopropagati non sono confermati per impostazione predefinita, ma vanno confermati 
premendo Ctrl+Enter. 

 
 

 
NOTA 
In uno dei prossimi capitoli si spiegherà come modificare le impostazioni predefinite relative 
all'autopropagazione, tra cui la conferma automatica dei segmenti autopropagati. 

 
 

VISUALIZZARE I FILTRI PER UNA REVISIONE PIÙ VELOCE 
 

Ora si esaminerà un altro caso di utilizzo della funzione Display Filter: dopo aver terminato la 

traduzione di un documento, si vogliono visionare velocemente tutti i segmenti pretradotti, vale a dire 

i 100% match e i context match. 
 

Per farlo, selezionare 100% match dal menu a tendina Display. L'editor mostra ora solo i segmenti 

pretradotti. Questa funzione permette di controllare il contenuto pretradotto. 
 

Se ci si vuole concentrare solo sul contenuto non pretradotto, selezionare New translated content dal 

menu a tendina Display. Vengono mostrati solo i segmenti non pretradotti (senza i 100% match e i 

fuzzy match). Questo fa risparmiare molto tempo nella fase di revisione, poiché vengono ignorati gli 

exact match. 

 

Ora che il documento è stato tradotto e revisionato, salvare le modifiche con il comando del menu File 
-> Save, poi chiudere il documento con File -> Close. 

 

 

EFFETTUARE UNA RICERCA IN DIVERSE TM 
 

Per tradurre il secondo file del progetto seguire queste istruzioni: 



 

 

 

 

1. Ritornare alla visualizzazione Files e fare doppio clic sul secondo documento traducibile 

(Language_Support.doc.sdlxliff) per aprirlo nell'Editor. 
 

 
 

 
2. Fare clic sul primo segmento del documento appena aperto. Si noti che un 99% match è 

stato suggerito per il segmento 1 (Language Support). Entrambi i segmenti sono mostrati 

nella finestra TranslationResults 
 
 
 

 
 

 
3. I due risultati provenienti dalla TM sono segnalati dall'icona verde +, che indica che due 

diverse soluzioni sono state trovate per lo stesso segmento source. Ogni volta che, come 

in questo caso, si verifica una traduzione multipla, viene applicata una penalità dell'1%. 

Questo è il motivo per cui i due risultati dalla TM non sono considerati 100% match. 

Esistono quindi vari match possibili, ed è l'utente a decidere quale traduzione si adatta 

meglio al contesto. 

 
4. Nella parte inferiore della finestra TranslationResults compare il nome della TM (ad 

esempio Software o General) in cui è stata trovata la corrispondenza. Se si preferisce 
inserire la seconda corrispondenza, fare clic sul pulsante Select Next Match nella barra 
degli strumenti della finestra TranslationResults e confermare il segmento con 
Ctrl+Enter. 

 

 
 



 

 

 

 
SUGGERIMENTI 
In alternativa, è possibile usare la combinazione di tasti Alt+2 per selezionare e inserire la 
seconda corrispondenza. 

 
 

PER ULTERIORI INFORMAZIONI 

Translation Results Window 

 

MODIFICARE LA SEGMENTAZIONE NEL CORSO DELLA 
TRADUZIONE 

 

Dividere i segmenti 
 

SDL Trados Studio 2011 segmenta i documenti source in base a una serie di regole predefinite. 

Ad esempio, i punti esclamativi e interrogativi e i due punti sono considerati delimitatori di 

segmento, mentre il punto e virgola e i cambi di pagina NON lo sono. Il segmento 2 contiene 

perciò due frasi, separate da un punto e virgola: 
 

 
 

 
Si può, tuttavia, cambiare la segmentazione nel corso della traduzione separando i segmenti. Se 

si vuole dividere questo segmento dopo il punto e virgola, perché si preferisce lavorare con 

segmenti più brevi, seguire questi passaggi: 
 

1. Posizionare il puntatore dopo il punto e virgola nel segmento source, poi fare clic con il 
pulsante destro del mouse. 
 

2. Selezionare Split Segment dal menu contestuale. 
 

 
 

 
3. Si osservi che il segmento 2 è stato diviso in due segmenti: 2a e 2b. Tradurre entrambi i 

segmenti e confermarli premendo Ctrl+Enter. 
 

 
 

 
 

Unire i segmenti 
 

Si osservi ora un esempio della funzione opposta, vale a dire l'unione di due segmenti separati. Si ipotizzi di 

voler unire i segmenti 3 e 4. Il segmento 3 contiene una sola parola, dato che i due punti dopo la parola 

Note sono considerati delimitatori di segmento. 
 



 

 

 

 
 

 
Per unire i segmenti 3 e 4, seguire questi passaggi: 

 
1. Fare clic sul numero di entrambi i segmenti tenendo contemporaneamente premuto il tasto Shift. 

 

 
 

NOTA 
Fare clic sui numeri di segmento e NON all'interno del testo source. 

 
 

2. Mentre il puntatore del mouse si trova ancora all'interno della colonna con i numeri di segmento, 
fare clic con il tasto destro del mouse e selezionare Merge Segments dal menu contestuale. 

 
 

 
 

 
3. I due segmenti sono ora uniti in un unico segmento. Tradurre e confermare il segmento 

premendo Ctrl+Enter. 
 
4. Tradurre l'ultimo segmento (il numero 5). Si noti che dopo aver unito i segmenti 3 e 4, il numero 4 

è scomparso e l'ultimo segmento ha ancora il numero 5. Questo significa che i segmenti di un 
documento non vengono rinumerati dopo l'operazione di unione, e i numeri di segmento sono 
perciò invariabili. 

 
5. Salvare il documento (File -> Save) e chiuderlo (File -> Close). 

 
 

NOTA 
Si possono unire solo i segmenti appartenenti allo stesso elemento strutturale, per esempio i 
segmenti dello stesso paragrafo. Non si possono quindi unire i segmenti 1 e 2a di questo documento 
di esempio, perché si trovano in paragrafi diversi. Se si prova a unire segmenti di paragrafi diversi, il 
comando Merge Segments appare grigio e inutilizzabile. 

 
 

CONTEXT MATCH 
 

Il prossimo documento da tradurre è un file di Power Point. Seguire questi passaggi: 
 

1. Tornare alla visualizzazione Files. 



 

 

 

 
 

 
2. Fare doppio clic sul file New_features.ppt.sdlxliff per aprirlo nella schermata Editor. Si noti che il 

primo segmento è stato pretradotto con un context match (CM), che è indicato con l'icona CM 

verde nella colonna dello stato della traduzione. Si può anche notare che la traduzione risulta 

confermata. 

 
 

Un CM è persino più sicuro di un 100% match. Si ha un CM in presenza delle seguenti condizioni: 
 

 Il segmento corrente è identico a un segmento tradotto in precedenza e contenuto nella TM. 

 Il segmento che precede quello corrente e la sua traduzione sono gli stessi di un documento 
tradotto in precedenza, cioè i segmenti si trovano nella stessa sequenza in cui si trovavano in un 
documento precedente. 

 
 

NOTA 
Ci si può chiedere perché nell’esempio mostrato venga segnalato un CM, dato che non risultano 
segmenti precedenti. Tuttavia, il fatto che il segmento corrente si trovi all'inizio del documento 
contribuisce a dare informazioni sul contesto. Poiché questo segmento si trovava all'inizio di un 
documento anche l'ultima volta che è stato tradotto, SDL Trados Studio restituisce un context 
match. 

 
SUGGERIMENTI 
Potrebbe essere necessario adattare le dimensioni del carattere per questo documento. Per farlo 
selezionare il comando del menu Tools ->Options. Nella finestra di dialogo Options fare clic su Editor -
> Font Adaptation. Successivamente attivare la casella di controllo Adapt font sizes e selezionare le 
dimensioni del carattere minime/massime per il testo source e target dai menu a tendina. 

 

ANTEPRIMA DEI FILE POWERPOINT  

Si supponga che, dopo aver tradotto il file PowerPoint, si voglia visualizzarne l'anteprima, ad 
esempio per controllare se il testo target non si trovi al di fuori delle caselle di testo create nelle 
slide. Per generare un'anteprima delle slide PowerPoint, procedere come indicato di seguito: 

1. Innanzitutto, assicurarsi che il cursore sia posizionato all'interno del primo segmento target. 

2. Muovere il puntatore del mouse sulla scheda Preview nell'angolo in alto a destra della finestra 

di applicazione. Questo farà apparire la finestra Preview. 



 

 

 



 

 

 

Prima di generare l'anteprima, disabilitare la funzione AutoHide, in modo che la finestra Preview non scompaia se 

viene mosso il puntatore del mouse. Per farlo, fare clic sul pulsante Auto Hide (l’icona a forma di spillo). 

 

3. L'icona a forma di spillo ora dovrebbe essere orientata verso il basso, il che indica che la 

finestra Preview è fissa. Per utilizzare al meglio la schermata, spostare la finestra Preview 

in modo che occupi il lato destro della finestra dell'applicazione. Per farlo, spostare il 

puntatore del mouse sulla barra del titolo della finestra e tenere premuto il tasto sinistro 

del mouse. 

 

4. Spostare la finestra. Si potrà trascinare la finestra liberamente e sullo schermo 

appariranno gli indicatori di direzione. 



 

 

 

5. Mentre si trascina la finestra, spostare il puntatore del mouse sull'indicatore di direzione 

situato a destra, quindi rilasciare il tasto del mouse. 

 

6. Ora la finestra di anteprima è fissata sul lato destro. Fare clic sul link al centro della 

finestra per generare l'anteprima. 

 



 

 

 

7. Qui sotto è possibile vedere come viene visualizzata nell'anteprima la prima slide. 

L'anteprima mostra solo la slide del segmento selezionato nella finestra Editor. 

 

8. Selezionare il secondo segmento, relativo alla slide 2. Si noti che nell'anteprima viene 

mostrata la slide corrispondente. 

 



 

 

                NOTA 

L'anteprima mostra un testo bianco su sfondo nero. Nella finestra Editor di SDL Trados 
Studio i caratteri appaiono in grigio, in modo che il testo sia leggibile su sfondo bianco. La 
regolazione dei colori avviene in automatico. Tuttavia, i colori NON vengono cambiati nel file 
PowerPoint. 

SUGGERIMENTI 
Quando viene ridotta la finestra Preview, è possibile fare clic sul pulsante Aggiorna per 
assicurarsi che la slide corrente sia visualizzata correttamente. 

 

Fare clic sul pulsante Close nell'angolo in alto a destra della finestra Preview per chiuderla. 

Salvare il documento facendo clic sul comando del menu File-->Save. Chiudere il documento 
facendo clic sul comando del menu File-->Close. 

PASSARE A UN SEGMENTO SPECIFICO  

Ora procedere come indicato di seguito per tradurre l'ultimo documento del progetto: 

1. Tornare alla finestra Files. 

2. Fare doppio clic sull'ultimo documento (The_Check_Spelling_Command.doc.sdlxliff) per 

tradurlo nella finestra Editor. 

 

Si noti che questo documento contiene solo due segmenti non tradotti. 

 

  



 

 

Questa volta, invece di utilizzare Display Filter per mostrare solo i segmenti non tradotti, per 
passare a un segmento di una categoria particolare procedere come indicato di seguito:  

1. Selezionare il comando del menu Edit -> Go To (oppure utilizzare la combinazione di tasti 
Crlt+G). 

2. Si apre la finestra di dialogo Go To. Selezionare Category tra le opzioni a sinistra della finestra di 
dialogo.  

3. Attivare la casella di controllo Untraslated, quindi cliccare su Next. 

 

4. Verrà mostrato direttamente il segmento non tradotto. Cliccare sul pulsante Close per chiudere 
la finestra di dialogo Go To. 

5. Si noti che il cursore ora è posizionato all'interno della cella target. È stato individuato un fuzzy 
match e la traduzione corrispondente è stata inserita nella cella target. Nella traduzione 
suggerita manca l'equivalente per on the toolbar e per il tag picture. 

 

6. Inserire il tag nella posizione corrispondente nel segmento target premendo Ctrl+, e 
selezionando il tag dalla lista QuickPlace. 

7. Terminare la traduzione del segmento corrente (ma NON confermarlo). 

 
PER ULTERIORI INFORMAZIONI 

The Go To Function 

CREAZIONE IMMEDIATA DI VOCI AUTOTEXT 
 

Prima di confermare il segmento corrente, si prenda in considerazione la frase seguente: anche 

questa contiene il termine toolbar, per il quale non è stato individuato alcun equivalente nel 

termbase né nel dizionario AutoSuggest. Tuttavia, questo termine è già stato tradotto nel 

segmento corrente (in questo caso con Barra degli strumenti). 

Se si pensa di incontrare molte volte lo stesso termine in questo o in altri documenti, è meglio 

aggiungerlo alla cosiddetta lista AutoText, in modo che venga visualizzata successivamente 



 

 

attraverso l'AutoSuggest. Per farlo: 

1. Evidenziare il termine target per la barra degli strumenti nel segmento 4 e premere Alt+F7. 

2. In questo modo si aprirà la finestra di dialogo AddAutoText Entry. Si noti che il termine target 
selezionato è già stato inserito. Fare clic sul pulsante Add per aggiungere la voce al campo della 
lista in basso e infine confermare premendo il pulsante OK. 

 

3. Confermare il segmento 4 premendo Ctrl+Enter. 

4. Iniziare a tradurre il segmento 5. Dopo aver digitato le prime 4 lettere del termine target per 

toolbar, verrà proposta una corrispondenza dell'AutoSuggest dalla vostra lista AutoText. Inserire 

il termine completo premendo Enter. 

 

Dopo aver terminato di tradurre il documento corrente, salvarlo selezionando il comando del 

menu File-->Save. Chiudere il documento selezionando il comando del menu File-->Close. 

 

NOTA 
Le stringhe aggiunte alla lista AutoText non fanno parte del termbase o del dizionario 
AutoSuggest, ma di una lista separata, visualizzabile selezionando il comando del menu Tools--
>Options. 

Selezionare quindi AutoSuggest ->AutoText ed estrarre il segmento target corrispondente dal 

menu a tendina Target Language. In questo modo verrà mostrata la lista delle voci AutoText 

disponibili. 



 

 

 

 

RIEPILOGO 
 

 La funzione Display Filter permette ad esempio di visualizzare facilmente solo i segmenti 
pretradotti al 100%, i segmenti appena tradotti, i segmenti non tradotti, ecc. 

 È possibile usare la funzione Display Filter per mostrare solo i segmenti contenenti un 
determinato termine. 

 Quando vi sono più corrispondenze nella TM, è possibile scorrerle premendo 
contemporaneamente Alt e il numero del match corrispondente. 

 Quando vengono proposte molte corrispondenze al 100%, ognuno di questi perde l'1% di 
corrispondenza. Ad esempio invece di due corrispondenze al 100% si vedranno due 
corrispondenze al 99%. 

 I tag per la formattazione carattere non sono mostrati per impostazione predefinita. 
Tuttavia, attraverso un pulsante della barra degli strumenti è possibile scegliere di visualizzare 
i tag della formattazione carattere, il che può tornare utile per rimuovere la formattazione da 
un segmento. 

 È possibile inserire velocemente i caratteri speciali come il trattino utilizzando il pulsante 
della barra degli strumenti corrispondente o i tasti di scelta rapida. 

 È possibile utilizzare la funzione To Go, visualizzabile premendo Ctrl+G, per passare a un 
determinato segmento, ad esempio il successivo segmento non tradotto. 

 È possibile modificare la segmentazione nel corso della traduzione, dividendo oppure 
unendo i segmenti. I segmenti che appartengono a elementi strutturali differenti (ad 
esempio paragrafi diversi) non possono essere uniti. 

 Per il file PowerPoint è possibile generare un'anteprima interattiva. Questa mostrerà solo 
la slide corrente. 

 SDL Trados Studio supporta le funzioni trova e sostituisci per sostituire velocemente le 
stringhe nei segmenti target. I segmenti modificati con la funzione trova e sostituisci 
devono essere riconfermati. 

 È possibile creare voci AutoText nel corso della traduzione, selezionando un termine 
target e premendo Alt+F7. Questa è la soluzione più veloce per aumentare le voci 
AutoSuggest. 

  



 

 

 
 
 
 
 
 
 
 
 
 
 

TERMINARE IL PROGETTO  
 
 
 
 
 
 

In questo capitolo si imparerà a: 
 

 Usare una batch task per generare i file target a 

partire dai file tradotti in formato SDL XLIFF, 

terminando così il progetto 

 Copiare i file target in una posizione a scelta 

(ad esempio per la consegna dei documenti 

target finiti) 
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TERMINARE IL PROGETTO 
 

Tutti i documenti source del progetto sono stati tradotti. Se si vogliono consegnare al 

committente i documenti target, è necessario:  
 

 Assicurarsi che tutto il contenuto dei file SDL XLIFF tradotti sia registrato nella TM. 
 Generare i file nel formato originario (DOCX e PPTX) partendo dai documenti SDL 

XLIFF tradotti. 

Per farlo, seguire questo procedimento: 

1. Passare alla visualizzazione Projects. 
 

 
 

 
 

2. Fare clic con il tasto destro sul progetto e selezionare Batch Tasks -> Finalize dal menu 
contestuale. 

 
 

3. Si apre la finestra di dialogo Batch Processing. La funzione Finalize svolge esattamente 

i due compiti richiesti, ossia aggiorna le TM e genera i documenti target nei rispettivi 

formati originari. Fare clic su Next per proseguire. 

 



 

 

4. La schermata seguente presenta l'elenco dei file di progetto e indica l'avanzamento 

della traduzione per ogni file. Una volta completata la traduzione di tutti i file, le 

barre di avanzamento dovrebbero essere al 100%. Fare clic su Finish per avviare la 

batch task. 

 
 

5. Attendere il completamento della batch task, quindi fare clic su Close. 

 
 

 
 

ESPORTARE I FILE TARGET 
 

Una volta generati i file target nei formati originari, prima di poterli inviare al 

committente sarà necessario scaricarli. Il modo migliore per farlo è esportare i file in una 

posizione a scelta. Procedere quindi come indicato di seguito: 



 

 

1. Fare di nuovo clic con il tasto destro del mouse sul nome del progetto e selezionare Batch 
Tasks -> Export files dal menu contestuale. 

2. Nella finestra di dialogo Batch Processing fare clic su Next. Viene visualizzata la pagina 

Files, dove compare l'elenco dei file da esportare. A questo punto fare 

semplicemente clic su Next. 

 
3. Nella pagina Settings procedere con i seguenti passaggi: sul lato sinistro selezionare All 

Language Pairs -> Batch Processing -> Export Files. 

 
4. Sul lato destro fare clic sul pulsante Browse e selezionare la cartella in cui si vogliono 

salvare i file target, ad esempio sul desktop. 

 
 

5. Fare clic su Finish, attendere il completamento dell'attività, quindi fare clic su Close. 

 
6. Aprire Esplora Risorse e cercare la cartella in cui sono stati esportati i file target. Con 

Export si creano sottocartelle per ogni lingua target: se la lingua target è l’italiano, i 

file target si troveranno nella sottocartella it-IT. 

 

CONTRASSEGNARE IL PROGETTO COME COMPLETO 
 

Una volta terminato il progetto, è necessario contrassegnarlo come completo. Questo 

risulta particolarmente utile nel caso in cui si stia lavorando su più progetti, perché 

permette di vedere quelli già completi. Con la batch task Finalize NON si classifica il 

progetto come completo: il progetto rimane In Progress. Per contrassegnare il progetto di 

esempio come completo seguire questo procedimento: 
 

1. Fare clic con il tasto destro del mouse sul nome del progetto nella schermata Projects e 

selezionare Mark as Complete dal menu contestuale. 



 

 

 
 

2. Quando richiesto, confermare con Yes. 

 
3. Ora nella colonna Status il progetto di esempio è indicato come Completed (ossia non più In 

Progress). 
 

 
 
 
 
 
 

RIEPILOGO 
 

 Una volta finito di tradurre tutti i file di un progetto, si può applicare la batch task 
Finalize per generare i file target nei rispettivi formati originari. 

 La batch task Finalize verifica inoltre che nella TM sia registrato il contenuto più 
recente del file target, il che è particolarmente utile quando il file SDL XLIFF non è 
stato tradotto dall'attuale traduttore, il quale però vuole importare il contenuto del 
file SDL XLIFF nella propria TM. 

 Con l'attività Export si possono copiare i file target dalla struttura della cartella di 
progetto a una posizione a scelta. 

 Una volta terminato il progetto, è bene contrassegnarlo come completo, affinché 
compaia come Completed nella schermata Projects. 

 



 

 

 
 
 
 
 

 

 

UNIRE I FILE DI PROGETTO  
 

 
 
 
 
 

In questo capitolo si imparerà a: 
 

 Creare un progetto basato su un modello di 

progetto 

 Unire diversi file in un unico documento SDL 

XLIFF per semplificare il lavoro 
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PROGETTO DI ESEMPIO 
 

Nel seguente esercizio si imparerà a configurare un nuovo progetto sulla base di un 

modello creato in precedenza durante la fase di impostazione del progetto. 
 

Si imparerà inoltre a unire i documenti source in un unico file SDL XLIFF. In alcuni casi, 

questo può risultare utile, dato che facilita operazioni come quella di ricerca e sostituzione. 

Inoltre può essere di aiuto nella gestione delle ripetizioni, dato che la funzione di 

autopropagazione si può applicare a tutti i file di progetto. 

 
NOTA 
Ovviamente, alla fine del progetto il file composto risulterà diviso nei file singoli. 

I sample file si trovano nella cartella seguente: ..\Sample Files\02 _Merging Files and Quality 
Assurance. 

 

Creare un progetto basato su un modello 
 

Per creare il nuovo progetto seguire questo procedimento: 
 

1. Fare clic sul pulsante  New Project nella barra degli strumenti per avviare il wizard New 
Project. 

 
 

2. Sulla schermata Project Type del wizard selezionare dal menu a tendina il modello salvato in 

precedenza. Poi fare clic su Next. 

 
3. Questa volta i documenti del progetto contengono le istruzioni su come cercare un 

termbase, quindi sulla schermata Project Details inserire il nome del progetto, per esempio 
Termbase Search. Selezionare una data di consegna, per esempio una settimana a partire dalla data 
in cui si crea il progetto, poi fare clic su Next. 

 
4. Il modello del progetto salva i parametri come le coppie di lingue. Poiché questa 

informazione è stata presa dal modello, fare semplicemente clic su Next per continuare. 



 

 

 

Selezionare e unire i file del progetto 
 

Sulla schermata Project Files è possibile aggiungere e unire i file su cui lavorare. Seguire questo 
procedimento: 

 
1. Questa volta al progetto sarà aggiunta una cartella. Fare clic sul pulsante Add Folder. 

 

 
2. Nella finestra di dialogo Browse For Folder selezionare la cartella che contiene i file source 

da tradurre, per esempio ..\02 - Merging Files and Quality Assurance\Documents. 

 
3. La struttura originale delle cartelle trova piena corrispondenza in Trados Studio. Sarà 

possibile visualizzare la cartella appena aggiunta sul lato sinistro, sotto il nome del 

progetto. Accanto alla cartella è possibile visualizzare il numero di file che questa 

contiene. Fare clic sulla cartella Documents per visualizzare i file che questa contiene sul 

lato destro.  

 



 

 

 

 

4. Selezionare tutti I file appena aggiunti. Poi fare clic sul pulsante Merge Files. 
 

 
 

 
5. Si apre la finestra di dialogo Merge Files. Scrivere i nomi dei file uniti nella casella di testo Merged 

file name. Questo sarà il nome del file SDL XLIFF che conterrà tutti i segmenti dei file 

individuali. Il nome può essere ad esempio MasterFile. Nell’elenco Files è possibile 

visualizzare i nomi dei file originali che verranno uniti. 



 

 

 
 

 
 NOTA 

I file source HTML non verranno uniti. Quando si uniscono i file, dai vari file source si genera 
un solo file SDL XLIFF, invece di un file SDL XLIFF per ogni documento source.  
È possibile anche unire file di tipo diverso. Ciò significa che per esempio è possibile unire file PPT con file 
DOC, XLS, HTML, ecc. 

 
SUGGERIMENTI 
Unire i file può essere particolarmente utile quando si ha a che fare con diversi file dal 
contenuto simile, per esempio i documenti che contengono molte ripetizioni. Questo è 
proprio il caso dei documenti in esempio. 

 

6. Ora fare clic su OK. Sulla pagina Project Files del wizard New Project si vedrà il nome del file 

composto del progetto. 

7. Fare clic sull’icona + accanto al file composto. Si espanderà così la visuale per mostrare i 

file source che questo contiene.  
 

 
 

 
8. A questo punto si può già fare clic su Finish per creare il progetto, poiché tutte le altre 

impostazioni (memorie di traduzione, termbase, batch task, ecc.) saranno prese dal 

modello. Questo esempio illustra come i modelli possano ottimizzare il processo di 

creazione del progetto in modo significativo. Quando si usa un modello, occorre solo 

dare un nome al progetto e aggiungere i file source. 



 

 

 
9. Una volta che tutti questi passaggi sono stati eseguiti, fare clic su Close. 

 

Visualizzare i file di partenza del progetto 
 

Per visualizzare i file di partenza del progetto seguire questo procedimento: 
 

1. Fare clic su Files per passare alla visualizzazione Files. 
 

 
 

 
2. Qui sarà visualizzato il file composto del progetto, in formato SDL XLIFF. Facendo clic 

sull’icona + accanto al file di partenza del progetto si può espandere la visuale per mostrare 

i nomi dei file source originali.  
 

 

 
3. Questa visuale mostra l’avanzamento generale e il numero di parole per il file 

composto e per i file individuali. 

 

Tradurre il file composto 
 

Per iniziare a tradurre il file composto seguire questo procedimento: 
 

1. Fare doppio clic sul file MasterFile.sdlxliff per tradurlo nella finestra Editor 

 
                NOTA 

Durante la traduzione, la modifica e la revisione si lavorerà solo sul file composto in 
formato SDL XLIFF. Solo terminando il progetto o salvando il file come target, l’applicazione 
dividerà il file composto in file singoli nel rispettivo formato originario (qui HTML). 

 

2. Si osservi il pannello Navigation sul lato sinistro della finestra dell’applicazione, che mostra il 

nome del file composto. Facendo clic sull’icona + accanto al nome è possibile espandere la 

visuale per mostrare i file singoli che il file unito contiene. 



 

 

 
 

3. È possibile passare rapidamente al file composto facendo clic sul nome del file 

corrispondente nel pannello Navigation. 

 
4. Inoltre, gli indicatori dei tag nel file composto segnalano la fine di un file e l’inizio di quello 

successivo. In questo modo è possibile accertare con facilità su quale file si sta lavorando.  
 

 
 

 
Assicurarsi di essere all’inizio del documento unito. Nei prossimi capitoli verrà spiegato 

come configurare le impostazioni per la verifica dei segmenti e tradurre il file mentre si 

sfrutta il potenziale QA di SDL Trados  Studio  2011. 
 

PER ULTERIORI INFORMAZIONI 

About Project Templates 
Merge Files 

 

RIEPILOGO 
 

 Usare i modelli di progetto può accelerare notevolmente la configurazione del progetto 
stesso. Se si hanno modelli di progetto con impostazioni predefinite come la selezione 
della TM, del termbase, ecc., occorre soltanto dare un nome al progetto e aggiungere 
i file source. 

 Si possono unire file diversi in un unico file. In questo modo si facilitano la gestione delle 
ripetizioni su diversi file, le operazioni globali di ricerca e sostituzione, ecc.  

 È possibile unire file di formato diverso (PPT, DOC, HTML, ecc.) in un file composto 
SDLXLIFF. 

 Utilizzando il pannello Navigation sul lato destro dell’editor è possibile passare 
velocemente da un file all’altro. 

 Una volta terminato il progetto, il file composto in formato SDLXLIFF viene diviso 
nuovamente nei singoli file. 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Projects_View/P_About_Project_Templates.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Projects_View/CreatProjects/P_Project_Files.htm#MiniTOCBookMark4


 

 

 
 
 
 
 

 

IMPOSTAZIONI DI VERIFICA 

DEI SEGMENTI 
 
 

 
In questo capitolo si spiegherà come: 
 
 Configurare le impostazioni per il controllo di 

qualità (QA) per verificare, ad esempio, le 

incongruenze nella punteggiatura, le ripetizioni, 

ecc. 

 Configurare le impostazioni di verifica 

terminologica per controllare, ad esempio, 

l’utilizzo di termini potenzialmente vietati 

 Esportare le impostazioni di QA in un file 
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LA VERIFICA DEI SEGMENTI 
 

Oltre al controllo ortografico e alla verifica dei tag, SDL Trados Studio 2011 può verificare i 

segmenti alla ricerca di problemi quali: 
 

 errori numerici 

 punteggiatura scorretta 

 ripetizioni 

 ripetizioni tradotte in modo incoerente 

 mancato utilizzo delle traduzioni suggerite dal termbase 

 utilizzo di termini potenzialmente vietati 

 ecc. 

 
Le verifiche avvengono nei seguenti modi: 

 

 In tempo reale; ad esempio quando si conferma una traduzione il segmento target 

viene controllato immediatamente, secondo un certo numero di criteri predefiniti 

dal QA. L’utente potrà notare un’icona di avviso accanto al segmento interessato. 

 Nella modalità batch; ad esempio un controllo QA viene eseguito sull’intero 

documento o su un gruppo di file dopo la traduzione. 
 

La versione corrente di SDL Trados Studio 2011 include due plug-in di verifica: 
 

 QA Checker 3.0 

 Terminology Verifier 

 

QA CHECKER 3.0 
 

 

Cos’è il QA Checker 3.0? 
 

SDL Trados Studio 2011 fornisce diverse funzioni per controllare le traduzioni alla ricerca di 

problemi potenziali come errori numerici, punteggiatura scorretta, problemi di lunghezza dei 

segmenti, ecc. 

Configurare il QA Checker 
 

Il QA Checker 3.0 offre un’ampia gamma di opzioni per il controllo di qualità, configurabili 

liberamente per adattarsi a requisiti di qualità molto particolari. In questa sezione si 

spiegherà come configurare alcune opzioni QA di uso comune.  
 

Le opzioni QA possono essere configurate in base a un progetto specifico, dato che un 

progetto può avere requisiti QA particolari. In questo esercizio verrà eseguita la 

configurazione del QA Checker appositamente per il progetto corrente. Ciò significa che 

prima di cominciare a tradurre verranno configurate le opzioni QA, in modo da poter 

beneficiare del controllo QA durante la traduzione. 
 

SUGGERIMENTI  
 

Le impostazioni QA possono anche essere configurate durante la creazione del progetto e 
salvate come parte di un modello di progetto. 

 

Per configurare le impostazioni QA seguire questo procedimento: 



 

 

Aprire le impostazioni di progetto 
 

1. Selezionare il comando Project->Project Settings dal menu. 
 

 
 

 

 
2. Nella finestra di dialogo Project Settings selezionare Verification -> QAChecker 3.0 sul 

lato sinistro. Questo mostrerà i collegamenti alle varie categorie delle impostazioni QA 

sul lato destro. 

 
 



 

 

Verifica del segmento 
 

1. Fare doppio clic su Segment Verification e controllare le opzioni sul lato destro della 

finestra di dialogo. L’unica impostazione predefinita attiva sarà Check for forgotten and 

empty translations. Questa impostazione cerca nel documento i segmenti che non 

sono stati tradotti. 

 
 

2. Ogni opzione di verifica è associata a tre diversi livelli di gravità: Error, Warning e Note, 

dove Error rappresenta il livello di maggior gravità. Questa categoria viene assegnata in 

modo predefinito alle parti non tradotte, dato che le omissioni costituiscono un 

problema serio. 

 
3. È ora possibile dare un’occhiata a un’altra opzione di questa pagina, vale a dire la 

verifica della lunghezza. Nel caso in cui ci sia stato qualche problema in precedenza con 

traduzioni rivelatesi più lunghe dei corrispondenti segmenti source, è possibile essere 

informati di tutti i segmenti target più lunghi dei segmenti source di oltre il 20%. 

 
4. Perché questo avvenga, occorre spuntare la casella Longer by. Sostituire il valore 

predefinito 50 con 20. Ciò significa che verranno segnalati tutti i segmenti target più 

lunghi dei segmenti source di oltre il 20% (impostazione basata in modo predefinito sul 

numero dei caratteri). 
 

 
 



 

 

Controllo delle incoerenze 
 

1. Ora fare clic su Inconsistencies; sul lato destro della finestra di dialogo apparirà un altro 

menu di impostazioni QA. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Spuntare anche la casella Check for inconsistent translations. Verrà effettuato un 

controllo sui segmenti ripetuti all’interno di un documento che sono stati tradotti in 

modo diverso.  

 
3. Spuntare anche la casella Check for repeated words in target. Questo evidenzierà i 

segmenti target contenenti ripetizioni, ad esempio you you said that. 

 
 
 
 

 

 

 

 

 

 

 

 

4. Il livello di gravità predefinito per questo tipo di errore è Warning, cioè “segnale 

giallo”. Se si considerano le ripetizioni un errore grave, poiché danno una brutta 

impressione del lavoro svolto, è possibile aumentare il livello di gravità a Error, 

selezionando il valore corrispondente dal menu a tendina.  
 

 



 

 

Controllo della punteggiatura 
 

1. Fare clic sul link Punctuation per visualizzare un'altra serie di opzioni relative a possibili 

errori di punteggiatura all'interno del documento.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

2. Attivare la casella di controllo Check that source and target end with the same punctuation. 

Quando si attiva questa opzione, l'applicazione segnalerà per esempio i segmenti che terminano 

con un punto di domanda nel segmento source, ma con un punto esclamativo nel segmento 

target. 

 
3. Una tipologia comune di errore sono gli spazi bianchi in eccesso. Per esempio, invece 

di inserire uno spazio si preme per errore due volte la barra spaziatrice. Si tratta 

certamente di un errore superficiale, ma difficile da individuare guardando 

semplicemente un segmento. Per controllare questo tipo di errore all'interno delle 

traduzioni, attivare la casella di controllo Check for multiple spaces. 
 

 



 

 

Controllo dei numeri 
 

L'ultima opzione da prendere in considerazione in questo esercizio è il controllo dei 
numeri. Fare clic sul link Numbers e poi attivare la casella di controllo Check Numbers sulla 
destra. 

 
 

Salvare il profilo QA Checker  
 

In questa sezione sono stati riportati solo alcuni esempi delle opzioni disponibili del QA 

Checker. Esistono in realtà molte altre opzioni che si possono attivare. Poiché le 

configurazioni del QA Checker possono essere abbastanza sofisticate e relative ai progetti, 

è possibile esportare le impostazioni del QA Checker in un file di configurazione. Questo 

file (o profilo QA Checker) può essere poi caricato, per esempio, in progetti successivi o 

inviato ad altri utenti.  
 

Per esportare le impostazioni del QA seguire questo procedimento: 
 

1. Fare clic sul link QA Checker Profiles. 
 
2. Quindi fare clic sul pulsante Export Settings. 

 
 



 

 

3. Nella finestra di dialogo Export Settings inserire un nome per il profilo QA Checker, per 
esempio MySettings. L'estensione *.sdlqasettings sarà automaticamente aggiunta al 
profilo. 

 
NOTA 
I profili possono essere caricati facendo clic sul pulsante Import Settings e 
selezionando il profilo. Qualsiasi impostazione QA esistente sarà sovrascritta 
importando un profilo. 

 

        SUGGERIMENTI 
Come specificare le impostazioni del QA Checker    

 

 
Ora che è stata terminata la configurazione del QA Checker, verrà preso in esame il 
modulo Terminology Verifier. 

 

 

TERMINOLOGY VERIFIER 
 

Che cos'è il Terminology Verifier? 
 

La verifica terminologica consente di controllare se è stata usata la terminologia corretta 
all'interno della traduzione. A questo scopo il documento tradotto viene verificato 
attraverso il confronto con un termbase. Ciò consente di controllare quanto segue: 

 

 Il traduttore ha effettivamente utilizzato i termini target provenienti dal termbase? 

 Il traduttore ha utilizzato termini che secondo il termbase non sono consentiti? 

 Il termbase contiene termini source che non hanno un termine target? 
 
 

Configurare il Terminology Verifier 
 

Per configurare il Terminology Verifier seguire questi passaggi: 

 
1. Fare clic sull'icona Verification. Assicurarsi che la casella di controllo del Terminology Verifier  sia 

selezionata. 
 

 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Edit_View/Translating/How_Set_QA_Check.htm


 

 

2. Selezionare ora Terminology Verifier -> Verification Settings. 

 

NOTA 
Le impostazioni di verifica che sono state configurate si riferiscono qui al termbase 
selezionato nel progetto o nel modello di progetto. Tale termbase si trova in Language 
Pairs -> All Language Pairs -> Termbases. 

 

 
 
 
 
 
 
 
 
 

3. Attivare quindi la casella di controllo Check for possible non-usage of target terms. Questa 

opzione verificherà se i termini target del termbase sono stati realmente utilizzati nella 

traduzione. 

4. Ad esempio, secondo il termbase bisogna tradurre il termine inglese user con utente. Se si 

traduce questo termine con, per esempio, operatore, il Terminology Verifier notificherà un 

errore. 
 

 
 

 
5. Attivare poi la casella di controllo Check for terms which may have been set as forbidden. 

Questa controllerà se nella traduzione sono presenti termini che (secondo il termbase) non 

sono consentiti. 
 

 
 

6. Il termbase di esempio utilizza un campo Status in cui è possibile contrassegnare se i 
termini sono consentiti o no. Selezionare il campo Status dal menu a tendina Term picklist 



 

 

fields. 
 

7. Scorrere l'elenco Select forbidden values e controllare i valori contrassegnati come not 
allowed.  

 
 

 
 

 
8. Infine fare clic su OK per chiudere la finestra di dialogo Project Settings e per applicare le 

impostazioni di verifica. 

 
PER ULTERIORI INFORMAZIONI 
 
Terminology Verifier > Verification Settings 

 

Nei seguenti capitoli si imparerà a usare la verifica dei segmenti durante e dopo la 
traduzione. 

 

 

RIEPILOGO 
 

 SDL Trados Studio 2011 offre ottimi plug-in totalmente configurabili per la verifica 
dei segmenti, oltre che per il controllo ortografico e la verifica dei tag. 

 QA Checker 3.0 può essere impostato per controllare che nei documenti target non 
vi siano omissioni, potenziali problemi di lunghezza, errori di numeri e punteggiatura, 
ecc. 

 Il Terminology Verifier controlla se nella traduzione non sono stati usati i termini 
target consigliati dal termbase e contrassegna il potenziale uso di termini che sono 
indicati come non consentiti. 

 Il termbase ha bisogno di avere un campo attributo che contrassegni un termine 
come, per esempio, non consentito, vietato, obsoleto, ecc. 

 

  

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Ref/Verification/TermVerifier_TermDef.htm


 

 

 

TRADURRE I FILE COMPOSTI  
 
 
 

In questo capitolo si imparerà a: 
 

 Configurare le opzioni di 

autopropagazione per la gestione delle 

ripetizioni 

 Selezionare il modulo di controllo 

ortografico preferito 

 Usare la verifica dei segmenti in tempo 

reale per garantire maggiore qualità e 

coerenza durante la traduzione 

 Usare il conteggio interattivo dei caratteri 

per visualizzare i limiti di lunghezza 

durante la traduzione 

 Cambiare le impostazioni della funzione di 

riconoscimento terminologico attivo 

 Visualizzare l’anteprima dei file HTML 
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AUTOPROPAGAZIONE 
 
Avviare la traduzione seguendo questi passaggi: 

 
1. Tradurre e confermare il primo segmento. In seguito alla conferma la traduzione viene propagata al segmento 3, che è 

una ripetizione del  segmento 1. 

 
 

2. Tradurre il segmento 2 (scrivere, ad esempio, Cercare nelle banche dati) e confermare premendo 
Ctrl+Enter. 

 
3. Si passa così al segmento 3 che è stato autopropagato. Si ipotizzi di voler tradurre diversamente 

tale segmento autopropagato e modificarlo con, ad esempio: 

 
 

4. Confermare la traduzione modificata premendo Ctrl+Enter. Si noti che lo sfondo 

dell’indicatore 100% match è diventato trasparente. Questo indica che una 

corrispondenza suggerita è stata modificata. 

 
È interessante notare che la prima occorrenza del segmento source non è stata modificata dalla 

funzione di autopropagazione. Ciò è dovuto alle seguenti regole predefinite che si applicano 

all’autopropagazione:  
 

C I segmenti confermati non vengono modificati dall’autopropagazione 

C L’autopropagazione non conferma i segmenti  

C L’autopropagazione funziona dall’alto verso il basso 
 

In questo capitolo si imparerà a cambiare le opzioni di autopropagazione, tuttavia per ora le 

impostazioni predefinite rimarranno invariate.  

 

 

VERIFICA TERMINOLOGICA NEL CORSO DELLA 
TRADUZIONE 

 
I segmenti 4 e 5 sono già stati pretradotti e perciò non verranno presi in considerazione.  
I tre segmenti successivi sono molto brevi, ad esempio Normal Search e Fuzzy Search. Tradurre i 
segmenti 6 e 7 inserendo i suggerimenti del termbase, quindi confermarli.  
 

 
 

Per il segmento 8 procedere come indicato di seguito: 



 

 

 
 

1. Si ipotizzi di non avere visto la traduzione proposta dal termbase per Full Text Search. 

Inserire un termine diverso da quello suggerito dal termbase (si osservi l’esempio qui 

sotto). 

2. Confermare il segmento premendo Ctrl+Enter. 

 
 

3. In seguito alla conferma compare un’icona di avviso di fianco al segmento. Spostare il 

cursore sull’icona per visualizzare la descrizione dettagliata dell’errore, ossia in questo 

caso il fatto che non è stato usato il termine suggerito dal termbase. 

 
4. Ritornare al segmento 8 e inserire il traducente del termbase. Si noti che l’icona di avviso diventa 

grigia appena si inizia a correggere il termine, dato che ora l’errore è in sospeso.  

 
 

5. Premere Ctrl+Enter per riconfermare il segmento. Si noti che in questo modo l’icona di 

avviso scompare.  

 

CONTROLLO DELLA PUNTEGGIATURA NEL CORSO 
DELLA TRADUZIONE 

 
Il segmento 9 (ossia Note:) può essere usato come esempio di come funziona il controllo della 

punteggiatura dal profilo QA Checker. Seguire i seguenti passaggi: 
 

1. Tradurre il segmento breve, omettendo i due punti finali di proposito. 
  

2. Confermare il segmento premendo Ctrl+Enter. 

 
3. Compare nuovamente un’icona di avviso. Muovere il cursore sull’icona di avviso per 

visualizzare la descrizione degli errori. Questa volta l’avviso riguarda il fatto che nel 

segmento target la punteggiatura finale non è coerente con quella del segmento source.  
 



 

 

 

 
4. Andare al segmento 9 e correggere il problema aggiungendo i due punti alla fine del segmento 

target e premere Ctrl+Enter per confermare. 

 

CAMBIARE LE IMPOSTAZIONI DI AUTOPROPAGAZIONE 
 

Ora proseguire come indicato di seguito: 
 

1. Confermare il segmento 11 che è stato autopropagato. Si passa quindi al segmento 12 che è stato 

autopropagato. 
 

2. Si ipotizzi di non essere soddisfatti di come sia stato tradotto il segmento la prima volta e 
di voler modificare il segmento target. Riformulare il segmento target, ad esempio: 

 
 

3. Quando si conferma il segmento, la prima occorrenza (segmento 2) rimane invariata. 
Tuttavia, per evitare di perdere tempo in operazioni di ricerca e sostituzione, è possibile 
autopropagare le modifiche di un segmento su tutte le occorrenze di tale segmento, anche 
se sono già state confermate e si trovano SOPRA il segmento corrente. 
 

4. Per cambiare le impostazioni di autopropagazione selezionare il comando dal menu Tools -> Options. Quindi 

spostarsi su Editor -> Auto-propagation. 

 
 



 

 

5. Nella finestra di dialogo Options attivare la casella di controllo Auto-propagate exact matches 
to confirmed segments. In questo modo verranno propagate le modifiche ai segmenti già 
confermati.  

 
6. Attivare quindi la casella di controllo Confirm segment after auto-propagating an exact match. 

In questo modo i segmenti autopropagati non dovranno più essere confermati manualmente. 

 

7. Infine selezionare First segment in the document nel menu a tendina Auto-propagate. 

In questo modo ogni modifica sarà propagata dall’inizio alla fine e viceversa. Le impostazioni 

dovrebbero ora avere il seguente aspetto: 
 

 
 

 
8. Fare clic su OK per confermare le modifiche delle impostazioni e chiudere la finestra di 

dialogo Options. 

 
9. Confermare il segmento corrente premendo Ctrl+Enter. 

 
10. Se si torna al segmento 2 si può notare che la prima occorrenza di questo segmento è stata 

modificata e confermata automaticamente. Si noti che questo segmento viene ripetuto 

anche in seguito nel documento. Tutte le occorrenze sono state cambiate e confermate.  

 
Confermare il segmento 13 premendo Ctrl+Enter. S i  a r r i v e rà  q u i nd i  a l  s eg m e nt o  1 7  n o n  

t ra d ot t o ,  c o nf e r m a n d o a u t om a t ic a m e nt e  i l  s eg m e nt o  1 6  ch e  è  s t a t o  

a ut o p r o pa g a t o .   

 
 
 

SELEZIONARE LO SPELL CHECKER PREFERITO 
 

Ora tradurre il segmento 17, per il quale non è stata trovata alcuna corrispondenza nelle TM, ad 
esempio: 

 

 
 

 
Prima di confermare il segmento, si osservino le opzioni di controllo ortografico disponibili: 
 
SDL Trados Studio 2011 supporta lo Spell Checker di Microsoft oltre a quello Hunspell. Usando lo 

Spell Checker di Word si avranno i seguenti vantaggi: 
 

 Maggiore qualità nel controllo ortografico, ossia meno errori di scrittura 



 

 

 Il riutilizzo delle impostazioni di controllo ortografico di Word, compresi i dizionari personalizzati 
 
Se si vuole utilizzare lo Spell Checker di Word e non quello Hunspell, cambiare le impostazioni 

seguendo questi passaggi: 
 

1. Selezionare il comando dal menu Tools -> Options 
 

2. Nella finestra di dialogo Options scorrere fino a Editor -> Spelling. 
 

3. Hunspell Spell Checker è attivo per impostazione predefinita. Selezionare MS Word Spell 

Checker dal menu a tendina Active Spell Checker.  

 
 

4. Se si vogliono configurare ulteriori opzioni (ad esempio Ignore words in UPPERCASE), è 

necessario farlo direttamente in Word. I dizionari personalizzati, inoltre, d’ora in poi verranno presi da 

Word. 

 
Da qui in poi le sottolineature usate per evidenziare i termini sconosciuti e gli errori ortografici 

verranno operate dallo Spell Checker di Word. Dopo aver cambiato lo Spell Checker si può vedere 

un effetto immediato, ossia la parola Termini che Hunspell segnalava come sconosciuta non è più 

sottolineata, perché viene riconosciuta dallo Spell Checker di Word: 

 

 
 

Confermare quindi il segmento successivo premendo Ctrl+Enter, si passerà quindi al segmento 22 

senza soffermarsi sui segmenti precedenti, che sono stati pretradotti e confermati. 

 

 

CONTROLLO DEI TERMINI VIETATI 
 

Per tradurre il segmento 22 procedere come indicato di seguito: 
 
 

1. Tradurre il segmento 22 usando le corrispondenze dal dizionario AutoSuggest e dal termbase. Si noti che il termbase 

offre due traduzioni del termine Hitlist, ossia: 



 

 

 
 

 

2. Tradurre il segmento usando il secondo termine suggerito dal termbase, ossia Elenco  risultati. 

Confermare premendo Ctrl+Enter. Dopo la conferma, accanto al segmento comparirà 

un’icona di errore rossa. 
 

 
 

3. Spostare il cursore sull’icona di errore. Verrà visualizzata la descrizione dettagliata: 
 

 
 

4. L’errore compare perché è stato usato un termine segnalato come vietato nel termbase.  

 

NOTA  
Inoltre, nell’esempio sopra, il segmento è più lungo di circa il 30% rispetto a quello 
originale. Tuttavia la questione più importante ora è il termine vietato.  

 
 
 

CONFIGUARE LE IMPOSTAZIONI HITLIST 
 

Come si può sapere che il secondo dei due termini proposti dal termbase non deve essere usato? 

Nella finestra Term Recognition non c’è un’indicazione riguardante lo stato di un termine, 

tuttavia le impostazioni per questa finestra si possono cambiare in modo che vengano mostrate 

maggiori informazioni. In questo modo si può vedere subito se un termine è contrassegnato 

come vietato o meno. Per farlo procedure come indicato di seguito: 



 

 

 

1. Fare clic sul pulsante Hitlist settings nella finestra Term Recognition. 
 

 
 

 
2. Nella finestra di dialogo Hitlist Settings fare clic sul pulsante Select Fields. 

 

 



 

 

 

 

3. Si apre la finestra di dialogo Field Selection che elenca tutti i campi del termbase 

disponibili in una struttura ad albero. Nel campo Status viene indicato se un termine è 

vietato o meno. Fare clic sulla casella di controllo Status sotto Target -> Term, quindi 

confermare facendo clic su OK. 
 

 
 

4. Fare clic ancora su OK per chiudere la finestra di dialogo Hitlist Settings. Si noti che 

l’informazione sullo  Status è mostrata ora accanto al termine corrispondente nella finestra 

Term Recognition. 

 

 
 

 
5. Tornare al segmento che contiene l’errore sul termine vietato e sostituire il termine vietato con 

quello approvato. Confermare il segmento premendo Ctrl+Enter, e l’icona di errore rossa 

verrà rimossa. 



 

 

 

CONTEGGIO CARATTERI INTERATTIVO 
 

Dopo aver sostituito il termine vietato, il segmento avrà il seguente aspetto: 
 

 
 

 
Si noti che ora accanto al segmento compare un'icona di informazione bianca. Procedere 
come indicato di seguito: 

 
1. Spostare il cursore sull'icona. Compare la descrizione dettagliata, ossia che il 

segmento target è più lungo di circa 25% rispetto al segmento source. 
 

 
 

 
2. Osservare ora la barra di stato in fondo alla finestra dell'applicazione. Si noti che la 

barra di stato indica il conteggio caratteri per il segmento corrente. 

 
 

 
3. Accorciare il segmento, ad esempio cancellando una parola. 

 

 
 

 
4. Si noti che accorciando il segmento, il conteggio caratteri nella barra di stato si 

aggiorna automaticamente. 
 

 
 

 
5. Confermare il segmento accorciato premendo Ctrl+Enter. In questo modo l'icona di 

informazione bianca viene rimossa dal segmento target, in quanto la traduzione non 

presenta problemi di lunghezza. 
 

 
 
 

  



 

 

 

ANTEPRIMA DEI FILE HTML 
 

Finire di tradurre il documento confermando tutti i segmenti rimanenti. 
 

Se si vuole vedere un'anteprima del file per sapere come vengono visualizzate le pagine 

Web nel browser, procedere come indicato di seguito: 

1. Spostare il cursore sulla scheda Preview nell'angolo in alto a destra della finestra 

dell'applicazione. Verrà visualizzata la finestra Preview. 
 

 
 

 

SUGGERIMENTI 
Può succedere che la scheda Preview non sia visibile, ad esempio se la finestra Preview 
è stata chiusa in uno degli esercizi precedenti. In questo caso selezionare il comando 

dal menu View -> Reset Window Layout. Confermare facendo clic su Yes. In questo 
modo saranno ripristinati il layout e la posizione predefiniti di tutte le finestre e, nel 
caso fosse stata nascosta, la scheda Preview sarà di nuovo visibile. 

 

2. Fare clic sul pulsante Auto Hide nell'angolo in alto a destra della finestra Preview per 

fare in modo che questa non scompaia una volta spostato il cursore. 
 

 
 

SUGGERIMENTI 
È possibile trascinare la finestra Preview e collocarla sul lato destro della finestra 
dell'applicazione, così da sfruttare lo spazio sullo schermo per l'anteprima. 

 

3. Fare clic sul link Click here to generate initial preview. In questo modo nella finestra 

Preview comparirà il layout del documento vero e proprio. 
 



 

 

 

 
 

4. Facendo clic su un segmento dell'anteprima, il segmento corrispondente nell'editor 
verrà evidenziato e viceversa. 

 

Si noti che si sta visualizzando l'anteprima di un documento composto, ossia un file che 

contiene più file source. Spostandosi su un segmento che appartiene a un altro 

documento, l'anteprima scompare e deve essere rigenerata per quella parte specifica del 

documento composto facendo di nuovo clic sul link. Questo significa che l'anteprima 

mostra solo il documento sul cui segmento è posizionato il cursore, ossia che non esiste 

un'anteprima unica per i documenti composti. 
 

Terminata la traduzione, salvare il documento selezionando il comando dal menu File -> 

Save e chiudere selezionando File -> Close. 

 

 

RIEPILOGO 
 

 Per impostazione predefinita, l'autopropagazione non modifica i segmenti 

confermati. Inoltre, per impostazione predefinita l'autopropagazione funziona 

solo dall'alto verso il basso. Tuttavia si possono modificare le impostazioni 

dell'autopropagazione per cambiare i segmenti già confermati e per 

autopropagare dal basso verso l'alto e viceversa. 

 Si possono usare sia i dizionari ortografici interni Hunspell o il controllo 

ortografico che permette di riutilizzare tutte le impostazioni e i dizionari 

personalizzati di Word. 

 Quando il QA Checker o il Terminology Verifier scoprono un errore nel segmento 

corrente, un'icona di errore, avviso o nota compare accanto al segmento una 

volta confermato. (Muoversi su e giù nell'editor non fa partire la verifica dei 

segmenti). 

 Una volta corretto l'errore e riconfermato il segmento, l'icona scompare. 

 Si possono personalizzare le impostazioni della finestra Term Recognition per 

visualizzare ulteriori campi oltre ai termini source e target, ad esempio il campo 

Status per accertare velocemente lo stato di un determinato termine. 

 La barra di stato mostra il numero di caratteri del segmento corrente, che si 

aggiorna man mano che si modifica il segmento. 

 Per i file composti l'anteprima mostra il contenuto del documento a cui 

appartiene il segmento attualmente selezionato nell'editor. 



 

 

 

 
 
 
 

 

 

REVISIONE DEI FILE 
 
 
 
 
 

In questo capitolo si imparerà a:  
 

 Tenere traccia automaticamente di ogni 

modifica apportata ai segmenti tradotti. 

 Aggiungere commenti ai segmenti 
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LA SITUAZIONE TIPO 
 

Nel caso in cui si voglia rivedere la traduzione a distanza di un giorno, SDL Trados Studio 

2011 offre una serie di strumenti che aiutano nella revisione dei testi target, in particolare 

la funzione Track Changes. Quest'ultima permette a chiunque di vedere cosa è stato 

modificato e in seguito di approvare o rifiutare la modifica. 

 

 

RINTRACCIARE LE MODIFICHE 
 

 

Riaprire il documento di esempio 
 

Per riaprire il file tradotto procedere come indicato di seguito: 
 

1. Assicurarsi di essere nella schermata Editor. 
 

2. Selezionare il comando dal menu File -> Recent Documents. 

 
3. Quindi scegliere il file di progetto, ad esempio MasterFile.sdlxliff. 

 
 

Attivare Track Changes 
 

Quando si apre un file per la traduzione, la funzione Track Changes è disattivata per 

impostazione predefinita. Per attivare la modalità Track Changes, procedere come indicato 

di seguito: 
 

1. Selezionare il comando dal menu Tools -> Track Changes. 
 

2. In questo modo si aprirà un menu contenente tutti i comandi legati a Track Changes. 
Fare clic sul primo comando, ossia Toggle Track Changes On/Off  per attivare la funzione Track 
Changes. 

 

 
 

3. Tornando su quel comando si vedrà un segno di spunta davanti a Toggle Track 

Changes On/Off. In questo modo è possibile accertarsi che la funzione sia attivata. 



 

 

 

 

 
 

 
Si noti che d'ora in poi tutte le modifiche fatte alla traduzione saranno segnalate. 

 
 

Rintracciare le modifiche 
 

Ora per apportare modifiche al documento seguire questi passaggi: 
 

1. Andare al segmento 5. Se la traduzione presa dalla TM durante la pretraduzione non 

piace, riformularla, ad esempio: 
 

 
 

 
2. Avendo modificato una corrispondenza proposta dalla TM lo sfondo dell'indicatore di 

CM (Context Match) è diventato trasparente; questo indica che è stata fatta una 

modifica. È possibile persino vedere esattamente la modifica apportata: le parti 

eliminate sono evidenziate con una barra rossa. Le aggiunte sono sottolineate. 

 
3. Spostare il cursore sulla parte cancellata. In questo modo si apre una descrizione 

dettagliata relativa alla modifica in questione. Per ogni modifica, SDL Trados Studio 

registra la data in cui è stata apportata, l'utente e il tipo di modifica, ossia 

inserimento o eliminazione. 

 
 

 
4. Si noti anche che ora lo status del segmento è Bozza, perché finché le modifiche sono 

provvisorie (cioè non sono state ancora accettate), il segmento corrispondente non 

deve essere confermato. 
 

NOTA 
La TM registra solo la versione finale del segmento target e non le modifiche segnalate.  

 

5. A questo punto NON confermare il segmento con Ctrl+Enter perché così facendo si 

accetterebbero le modifiche. Inoltre si rimuoverebbero tutte le modifiche segnalate 

dal segmento corrente. 

 
6. Usare invece il pulsante Freccia Giù per andare al segmento 14. Si ipotizzi di voler 

fare un’altra modifica per ragioni stilistiche, ad esempio: 
 

 
  



 

 

 

 

 
SUGGERIMENTI 
Le parti eliminate sono barrate ma NON sono incluse nel conteggio dei caratteri. 

 
 

AGGIUNGERE COMMENTI 
 

Oltre a tenere traccia delle modifiche si possono anche aggiungere commenti. Questo è utile 
quando si vuole: 

 

 Inserire una nota per sé, in modo da poter tornare in seguito a quel segmento 
specifico. 

 Aggiungere una nota per qualcun altro, ad esempio un revisore o un project manager. 

 

Si ipotizzi di non essere certi come tradurre la parola termbase e di voler controllare con 

un collega di aver tradotto correttamente. Perciò si contrassegna il segmento in modo da 

ricordare di ritornarci in seguito. Per farlo seguire questi passaggi: 
 

1. Andare al segmento 12. 
 

2. Evidenziare il termine target per termbase, ossia Glossario. 

 
3. Fare clic sul pulsante della barra degli strumenti Add a New Comment or a New Comment Version  

o premere Ctrl+Shift+N. 
 

 
 

 
4. Inserire un commento nella finestra di dialogo Add Comment, ad esempio Controllare con 

Dave se la traduzione è corretta. 
 

 
 

 
5. Ora fare clic su OK. Si noti che la parola commentata viene evidenziata con uno 

sfondo giallo. 

 
6. Spostare il cursore sulla parola commentata. In questo modo si ottengono ulteriori 

informazioni sul commento come la data in cui è stato inserito, il testo e il nome 



 

 

 

 

dell'utente che lo ha inserito. 
 

 
 

PER ULTERIORI INFORMAZIONI 
 
How to Review Suggested Changes 

 
 

RIEPILOGO 
 

 È possibile attivare o disattivare la funzione Track Changes. Quando un file è aperto 

per la traduzione, le modifiche, per impostazione predefinita, non vengono 

segnalate. 

 Quando la funzione Track Changes è attiva, SDL Trados Studio usa una barra rossa per 

evidenziare gli elementi eliminati e la sottolineatura per evidenziare le aggiunte.  

 Per ogni modifica, SDL Trados Studio registra la data in cui è stata fatta, l'utente e il 

tipo di modifica, ossia inserimento o eliminazione. 

 Per accettare le modifiche confermare il segmento. 

 SDL Trados Studio permette di aggiungere commenti ai segmenti o a particolari 

stringhe di testo per fare una nota per sé o per un'altra persona come il revisore o il 

project manager. 

 
  

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Edit_View/AcceptRejectTrackChanges.htm


 

 

 

 

 

 

 

 

 

CONTROLLO DI QUALITÀ 

AUTOMATICO  
 
 
 
 

 
Nel seguente capitolo si imparerà a: 

 

 Eseguire la verifica dei segmenti sull'intero 

documento 

 Correggere gli errori con l'aiuto del QA 

Checker 
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LANCIARE LA VERIFICA DELL'INTERO DOCUMENTO 
 

In uno dei capitoli precedenti si è spiegata la procedura per lanciare la verifica di singoli 

segmenti in tempo reale durante la traduzione. Ora si imparerà a lanciare la verifica dei 

segmenti sull'intero documento, anche di quelli pretradotti, così da individuare eventuali 

problemi. 
 

Alcuni di questi, come la ripetizione di parole o spazi in eccesso, possono essere corretti in 

modo semiautomatico con la funzione di verifica. Queste modifiche vengono segnalate se 

la funzione Track Changes è attiva. Se non si vogliono segnalare le modifiche, va disattivata 

questa funzione selezionando Track Changes -> Toggle Track Changes On/Off nel menu Tools. 
 

 
 

 
 

Lanciare la verifica dei segmenti 
 

Per lanciare la verifica dei segmenti, procedere come indicato di seguito: 
 

1. Selezionare il comando dal menu Tools  -> Verify  o premere F8. Verranno così avviate tutte 

le funzioni di verifica configurate, ad esempio il QA Checker e il Terminology Verifier. 
 

2. Dopo aver lanciato la verifica, la finestra Translation Results lascerà il posto alla 
finestra Messages, che contiene un elenco delle occorrenze riscontrate. 

 
 

3. La finestra Messages contiene la descrizione degli errori - ad esempio la dicitura 

Repeated word found (Riscontrate ripetizioni) -, la loro gravità, il nome del file in cui 

sono stati trovati problemi, così come il nome della funzione di verifica che li ha 

individuati, in questo caso QA Checker 3.0. 

 

NOTA 
Le modifiche che contengono modifiche segnalate non possono essere verificate, 
come indicato anche nell'elenco Messages dal Document Verifier. 



 

 

 

 

 
 
 

4. I messaggi possono essere filtrati a seconda della gravità, per esempio visualizzando 

l’elenco delle note di bassa priorità (icona di informazione bianca). In questo 

esercizio le Note si riferiscono ai segmenti con modifiche segnalate che non possono 

essere verificate e con problemi di lunghezza (ossia segmenti più lunghi rispetto al 

segmento source). Per ottenere una panoramica degli errori e degli avvisi più 

importanti fare click sul pulsante Show/Hide Notes. 

 

 
 
 
 

5. Come si può notare, l'elenco è molto più breve ora, ossia contiene soltanto i 

problemi più importanti. Per visualizzare ancora tutti i messaggi, fare di nuovo click 

sul pulsante Show/Hide Notes. 

 
 

Correggere gli errori 
 

La verifica dei segmenti non solo riferisce i problemi trovati, ma è anche utile per 

correggere gli errori. Procedere come indicato di seguito: 
 

1. Fare doppio clic sulla prima icona della finestra Messages. 
 

2. Si aprirà la finestra Verification Message Details che fornisce maggiori informazioni sul 

problema riscontrato. In questo caso un segmento ripetuto è stato tradotto in 

maniera incoerente. È possibile modificare la traduzione nel campo di testo Target 

Segment Content di questa finestra di dialogo. Sarebbe comunque preferibile rivedere 

l'intero documento, così da prendere una decisione consapevole su come risolvere il 

problema. Fare clic su Next per passare oltre senza correggere questo problema, su 

cui si tornerà più avanti. 



 

 

 

 

 

 

3. Il prossimo messaggio indica uno spazio in eccesso che è stato individuato nel 

segmento target. È il tipo di problema che la funzione di verifica può risolvere in 

automatico, vale a dire che non è necessario tornare al testo e correggere l'errore 

manualmente. Fare clic su Change. Verrà così eliminato lo spazio in eccesso e si 

passerà al prossimo problema. 

4.  

 

 

 

5. Il prossimo caso è quello di una parola ripetuta due volte di seguito. Anche questo 

tipo di problema è facilmente risolvibile facendo clic su Change. Non è quindi 

necessaria alcuna modifica manuale. 
 



 

 

 

 

 
 

6. Dato che il segmento appena modificato è ripetuto tre volte nel documento e 

presenta lo stesso errore ogni volta, il problema verrà segnalato di nuovo. Facendo 

due volte clic su Change verranno corretti anche gli altri due segmenti. 

7. Il prossimo messaggio indica che c'è un errore numerico: nel segmento target 
leggiamo 250 invece di 25. 

 

Nella finestra Verification Message Details si possono vedere i segmenti source e target. Infatti, il 

segmento target contiene un numero sbagliato. Correggere il numero direttamente nel 

campo di testo Target Segment Content. Quindi fare clic su Change per apportare la modifica 

all'intero documento e proseguire al segmento successivo. 

 
  



 

 

 

 

 
 

NOTA 
Nell'esempio precedente era stato necessario cambiare il numero manualmente 
prima di cliccare su Change. Questo si deve al fatto che gli errori numerici sono più 
complessi da gestire rispetto, ad esempio, agli spazi in eccesso. In alcuni casi è 
necessario inserire un numero diverso nel segmento target, ad esempio quando si fa 
riferimento a una valuta diversa (euro da convertire in dollari). 

 

8. Come menzionato in precedenza, la verifica dei segmenti non si applica ai segmenti 

che contengono modifiche segnalate. Ma il fatto che non è possibile sottoporre a 

modifica il prossimo segmento, perché contiene modifiche segnalate, viene 

comunque indicato. Per ignorare il messaggio, fare clic su Ignore, e il messaggio 

verrà eliminato dalla lista. 

 
 

9. Ripetere i passaggi precedenti per il prossimo segmento, che contiene modifiche 
segnalate e quindi non è stato sottoposto a verifica. 

 
NOTA 
Mentre facendo clic su Ignore il messaggio viene rimosso, il comando Next permette 
di conservare il messaggio nella lista e di correggerlo in un secondo momento. 

 

10. Il nostro documento contiene alcuni segmenti che sono più lunghi del 20% rispetto al 

testo source. Se non si vogliono modificare questi segmenti perché la lunghezza del 

segmento target è ancora entro i limiti ragionevoli, fare clic su Ignore All per saltare 

tutti i messaggi di questo tipo. 
 



 

 

 

 

 
 

11. Compare un messaggio in cui si segnala che la funzione di verifica non ha riscontrato 
altri problemi. Chiudere la finestra di dialogo facendo clic su OK. 

 
12. Ora nel documento dovrebbe essere rimasto solo un avviso, ossia quello che segnala 

la ripetizione tradotta in modo incoerente. 

 
 

 
NOTA 
Si noti che il messaggio e le icone corrispondenti saranno rimossi per tutti i segmenti 
modificati 

o ignorati. 
 

13. Quest'incoerenza è stata causata dal fatto che il segmento 3 è stato tradotto in modo 

diverso rispetto al segmento 1. Tuttavia la nuova traduzione non è stata 

autopropagata al primo segmento, poiché per impostazione predefinita 

l'autopropagazione funziona solo dall'alto verso il basso. Dato che le impostazioni 

dell'autopropagazione sono state nel frattempo modificate, la riconferma del 

segmento 3 aggiornerà automaticamente anche il segmento 1. Premere Ctrl+Enter per 

autopropagare la traduzione del terzo segmento al primo. 
 

 

 

 



 

 

 

 

  



 

 

 

 

RIEPILOGO 
 

 La verifica dei segmenti sull'intero documento può essere lanciata premendo F8 oppure 

selezionando il comando Tools -> Verify dal menu. 

 Eventuali problemi riscontrati saranno elencati nella finestra Messages. 

 Facendo doppio clic sul messaggio si apre la finestra di dialogo Verification Message 

Details che contiene maggiori informazioni riguardo a un problema specifico. 

 Alcuni problemi, come gli spazi in eccesso o le ripetizioni, possono essere corretti 

semplicemente facendo clic su Change nella finestra di dialogo Verification Message 

Details. 

 Per ragioni di sicurezza, alcuni errori, come per esempio gli errori numerici, devono essere 

modificati manualmente. Le modifiche apportate possono essere inserite direttamente 

nella finestra di dialogo Verification Message Details. 

 È possibile fare clic su Ignore per ignorare un problema specifico. Verranno così eliminati il 

messaggio e l'icona corrispondenti. 

 Facendo clic su Ignore All vengono eliminati i messaggi e le icone di tutti i casi relativi a una 

categoria specifica di problemi, per esempio ignorare tutti i problemi relativi alla lunghezza 

del segmento. 

 Facendo clic su Next si passa dal problema corrente a quello successivo. Tale funzione 

permette di tornare a quello specifico problema successivamente, ossia facendo clic su 

Next non si rimuove il messaggio e l'icona corrispondenti. 

 Se la funzione Track Changes è attiva, tutte le modifiche apportate dalla funzione di verifica 

dei segmenti saranno segnalate. 

 
  



 

 

 

 

 
 
 
 
 

 

TERMINARE IL PROGETTO 
 
 
 
 
 

Nel seguente capitolo si imparerà a: 
 

 Filtrare i segmenti con modifiche e 

commenti segnalati 

 Accettare e rifiutare le modifiche segnalate 

 Terminare il progetto e generare i file target 

dal file composto 
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FILTRARE I SEGMENTI MODIFICATI 
 

Si supponga di voler vedere tutti i segmenti modificati e decidere quali modifiche 

mantenere e quali scartare. Per facilitare questa operazione, usare la funzione Display 

Filter per visualizzare solo i segmenti contenenti revisioni. 
 

Per farlo, selezionare With tracked changes dall’elenco a tendina Display. 

 
 

 

ACCETTARE E RIFIUTARE LE MODIFICHE 
 

A questo punto nell’editor sono visibili solamente i segmenti contenenti revisioni. 

Assicurarsi che il cursore sia posizionato sul primo segmento: 

 
 

Accettare una modifica 
 

Per accettare la modifica effettuata nel primo segmento procedere come indicato di 
seguito: 

 
1. Mentre si è posizionati sul primo segmento target premere Ctrl+Enter. 

 
2. Verrà richiesto di confermare i segmenti e di accettare tutte le modifiche. Fare clic su 

Yes per confermare. 

 
3. Questo modifica lo stato del primo segmento in confermato, quindi tradotto, ed 

elimina tutte le revisioni. 
 

 

Rifiutare una modifica 
 

Si supponga, una volta passati al secondo segmento, di voler rifiutare la modifica effettuata 

poiché si preferisce la traduzione originale.  
 

 
 

Per farlo procedere come indicato di seguito: 
 

1. Fare clic con il tasto destro del mouse sull’espressione segnalata e selezionare Reject 

Change dal menu contestuale. 
 

2. Ripetere l’operazione per tutte le altre revisioni all’interno del segmento. 



 

 

 

 

 

 
 
 
 

NOTA 
È possibile anche usare la combinazione di tasti Alt+Shift+F9 per rifiutare una modifica 
e Ctrl+Shift+F9 per accettarla. 

 
 

3. Adesso che tutte le revisioni sono state rimosse premere Ctrl+Enter per confermare 
il segmento. 

 
 

Selezionare a questo punto All segments dal menu a tendina Display per visualizzare 
nuovamente tutti i segmenti. 

 

 
 
 
 

ELIMINARE I COMMENTI 
 

Occorre ricordare che in qualche punto del documento è ancora presente un commento. Si 

supponga che nel frattempo sia stato controllato e confermato il termine commentato da 

un collega. A questo punto si vorrà rimuovere il commento in questione. Per farlo, 

procedere come indicato di seguito: 
 

1. Fare clic sulla scheda Comments per visualizzare l’elenco dei commenti. 
 

2. Fare clic sul pulsante Delete Comment nella barra degli strumenti per rimuovere il 

commento dall’elenco e quindi dall’intero documento. 

 
 

 
Salvare quindi il documento usando il comando File -> Save dal menu e chiuderlo 

selezionando File -> Close. 

 

 

TERMINARE IL PROGETTO 
 

Ora che la traduzione è stata interamente rivista, è possibile terminare il progetto. Per 
farlo, procedere come indicato di seguito: 



 

 

 

 

 
1. Passare alla schermata Projects. 

 

  
 

2. Fare clic con il tasto destro del mouse sul progetto e selezionare Batch Tasks -> 
Finalize dal menu contestuale. 

3. Nella finestra di dialogo Batch Tasks fare clic su Next. 

 
 

4. Nella schermata successiva fare clic su Finish per avviare i batch task. In questo 

modo si genereranno anche documenti target singoli dal file composto in formato 

SDL XLIFF. 

 
5. Una volta completati i batch task fare clic su Close. 



 

 

 

 

 
 

 
Esportare i file target 

 
Per recuperare i documenti target singoli, procedere come indicato di seguito: 

 
1. Fare clic con il tasto destro del mouse sul progetto e selezionare Batch Tasks -> 

Export files dal menu contestuale. 
 

2. Nella finestra di dialogo Batch Processing fare clic su Next; si aprirà la schermata 

Files dove sono elencati i file target da esportare. Fare clic su Next. 

3. Nella pagina Settings procedere come segue: sul lato sinistro della pagina 

selezionare All Language Pairs -> Batch Processing -> Export Files. 

 
4. Sul lato destro della pagina fare clic su Browse e selezionare la cartella dove si 

vogliono riporre i file target, ad esempio il desktop. 

 



 

 

 

 

 
5. Fare clic su Finish, quindi attendere il completamento dell’attività e infine fare clic su 

Close. 

 
6. Aprire Windows Explorer e selezionare la cartella nella quale erano stati esportati i 

file target. Si noti che l’opzione Export crea sottocartelle per ogni lingua target. Ad 

esempio, se la lingua target di lavoro è l’italiano, i file target si troveranno nella 

sottocartella it-IT. Questa cartella ora contiene i file target in formato HTML. 

 
 

Contrassegnare il progetto come completo  
 

Una volta terminato il progetto è possibile contrassegnarlo come completo. Tale 

eventualità è particolarmente utile se si sta lavorando a più progetti e si vuole vedere quali 

tra questi sono già stati completati. Per segnalare il progetto come completo procedere 

come indicato di seguito: 
 

1. Nella schermata Projects fare clic col tasto destro del mouse sul progetto e 

selezionare Mark as Complete dal menu di scelta rapida. 

  
 

2. Quando richiesto, confermare facendo clic su Yes. 

 
3. Si noti che la colonna Status ora indica il progetto come Completed (e non più In 

Progress). 

  



 

 

 

 

 
 
 

RIEPILOGO 
 

 Con il Display Filter è possibile visualizzare solo i segmenti contenenti revisioni. 

 Le revisioni si accettano premendo Ctrl+Enter all’interno del segmento e vengono 
confermate facendo clic su Yes nella finestra di messaggio. 

 È possibile fare clic con il tasto destro del mouse su una modifica e selezionare il 
comando di menu di scelta rapida corrispondente per accettarla o rifiutarla. 

 È possibile cancellare i commenti dalla finestra dei Comments facendo clic su Delete 
Comment nella barra del menu. 

 Una volta terminato un progetto che contiene file composti, si creano i singoli file 
target dal file SDL XLIFF composto facendo clic su Finalize. 

  



 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

PERSONALIZZARE LE COMBINAZIONI  

DI TASTI DI SCELTA RAPIDA  
 
 
 
 
 

Nel seguente capitolo si imparerà a: 
 

 Personalizzare le combinazioni di tasti di scelta 

rapida per soddisfare il proprio stile di lavoro 
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PERSONALIZZARE LE COMBINAZIONI DI TASTI DI 
SCELTA RAPIDA PER UNA FUNZIONE PARTICOLARE 

 
Per una massima produttività tutte le funzioni di SDL Trados Studio 2011 sono accessibili 

tramite combinazioni di tasti. L'applicazione consente di definire le combinazioni di tasti 

preferite. 
 
Esempio: La combinazione di tasti predefinita per la funzione Copy Source to Target (ossia il 

tasto che copia il segmento source nella cella target) è Alt+Ins o Ctrl+Ins. Se si usa questa 

funzione di frequente, ma si lavora con un computer dove il tasto Ins è in una posizione 

scomoda, è troppo piccolo o non c’è direttamente, è possibile modificare la combinazione 

di tasti per questa funzione come indicato di seguito: 

 
1. Selezionare il comando dal menu Tools -> Options. 
 
2. Nella finestra di dialogo Options fare clic ed espandere Keyboard Shortcuts. 

 
 

3. Le combinazioni di tasti specifiche di una schermata sono elencate sotto il titolo 
corrispondente. 

La funzione Copy Source to Target è disponibile nella schermata Editor, quindi si può 

trovare più facilmente la combinazione di tasti se si fa clic sul link Editor. 

 
4. Trovare la funzione Copy Source to Target e fare clic all'interno della colonna 

Shortcut vicino al nome della funzione, dove si trova la combinazione di tasti 

predefinita, Alt+Ins, Ctrl+Ins. 

 
5. Ora premere la nuova combinazione di tasti preferita, Ctrl+Alt+I, che andrà a 

sostituire la combinazione di tasti predefinita. 



 

 

 

 

 
 

6. Fare clic su OK per confermare e chiudere la finestra di dialogo Options. 

 
Controllare se la nuova combinazione di tasti funziona. Aprire il file sample.doc che si trova 

nella cartella dei sample file, ossia ..\Sample Files\03_Customizing Keyboard Shortcuts, e 

usare la funzione Copy Source to Target mediante la nuova combinazione di tasti. 
 

 

PER ULTERIORI INFORMAZIONI 

How to View and Edit Keyboard Shortcuts 

http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Introducing/SpecifyKSs.htm


 

 

 
 
 
 
 

 

CORSI DI APPROFONDIMENTO  
 
 
 
 
 
 

Questo capitolo fornisce una panoramica di ulteriori 

corsi che permettono di approfondire l'argomento e 

di rendere il lavoro più produttivo. 

 

 
 
 
 
 
 
 
 

Capitolo 

13 



 

 

 

ULTERIORI CORSI CONSIGLIATI 
 

Col completamento del corso SDL Trados Studio 2011 - Parti I e II - si sono acquisite le 

conoscenze necessarie per  tradurre e revisionare documenti in maniera efficace. Se si 

desidera approfondire l'argomento, si consigliano i seguenti corsi: 

 
 

SDL Trados Studio 2011 - Advanced 
 

Il corso è rivolto ai traduttori che hanno completato i corsi SDL Trados Studio 2011 - Parti I 

e II - e ai project manager che hanno completato il corso per Project Manager SDL Trados 

Studio 2011. 
 
Il corso tratta i seguenti argomenti: 
 

 Mantenere le risorse della TM snelle ed efficienti mediante un'efficace 
manutenzione della TM 

 Migliorare la TM mediante opzioni di rifinitura, elenchi di variabili e campi di attributi 
o di testo personalizzati 

 Localizzare efficacemente il contenuto XML 

 Migliorare il controllo di qualità automatico mediante regole personalizzate 

 Migliorare e personalizzare il flusso di lavoro di localizzazione per diversi tipi di file: 
Word, PowerPoint, Excel, Adobe In Design 

 Simulazione della traduzione da e verso la lingua per identificare i problemi di 
traduzione più comuni prima di cominciare effettivamente a tradurre 

 
 

SDL MultiTerm 2011 
 

Nei corsi SDL Trados Studio 2011 si è imparato a usare termbase già esistenti durante il 

processo di localizzazione. 
 

Per sfruttare appieno il potenziale della propria soluzione terminologica, si consiglia di fare 

riferimento al corso dedicato SDL MultiTerm 2011 che tratta i seguenti argomenti: 
 

 Introduzione ai concetti base di terminologia 

 Panoramica dell'applicazione SDL MultiTerm 2011 

 Come cercare in modo efficace un database terminologico (termbase) 

 Come definire i filtri per affinare la ricerca 

 Convertire i glossari esistenti nel formato MS Excel da utilizzare in SDL MultiTerm 
2011 

 Creare il proprio termbase personalizzato da zero 

 Aggiungere voci al termbase 

 Aggiungere e modificare le voci più efficacemente mediante modelli input 

 Sfruttare i vecchi documenti per compilare velocemente il termbase attraverso 
l'estrazione terminologica 

 Accedere ai termbase da SDL Trados Studio 2011 

 Esportare il contenuto del termbase in tabelle e dizionari stampabili 

 Panoramica di SDL MultiTerm Online 
  



 

 

 


